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Trademarks 
Unigraf, UCD, UCD-424, UCD-400, UCD-300 and TSI are trademarks of Unigraf Oy. 

DisplayPort™ and the DisplayPort™ logo are trademarks owned by the  

Video Electronics Standards Association (VESA®) in the United States and other countries. 

USB™, USB Type-C™ and USB-C™ are trademarks of USB Implementers Forum Inc. 

HDCP is a trademark of Digital Content Protection LLC. 

Windows® 10, Windows® 8, Windows® 7 and Windows® XP are trademarks of  

Microsoft Corporation. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, 

under normal use and service, for twelve (12) months from the date of purchase from Unigraf 

or its authorized dealer. 

If the product proves defective within the warranty period, Unigraf will provide repair or 

replacement of the product. Unigraf shall have the whole discretion whether to repair or 

replace, and replacement product may be new or reconditioned. Replacement product shall be 

of equivalent or better specifications, relative to the defective product, but need not to be 

identical. Any product or part repaired by Unigraf pursuant to this warranty shall have a 

warranty period of not less than 90 days, from the date of such repair, irrespective of any 

earlier expiration of original warranty period. When Unigraf provides replacement, then the 

defective product becomes the property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf 

will provide instructions for returning the defective product. 

CE Mark 
UCD-424 products meet the essential health and safety requirements, is in conformity with and 

the CE marking has been applied according to the relevant EU Directives using the relevant 

section of the corresponding standards and other normative documents. 
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 ABOUT THIS MANUAL 

Purpose 
This guide is User Manual of UCD-424, USB-connected video interface test unit for use 

with a PC with Windows® 10 Windows® 8 or Windows® 7 operating system. 

The purpose of this guide is to 

• Provide an overview of the product and its features. 

• Provide instructions for the user on how to install the software and the drivers. 

• Provide instructions for the user on how to update the FW of the unit. 

• Introduce the HW features of the UCD-424 units. 

• Provide instructions for the user on how to use UCD Console software. 

Product and Driver Version 
This manual explains features found in UCD Console Software Package 1.10. Please 

consult Unigraf for differences or upgrades of previous versions.  

Please consult the Release Notes document in the installation package for details of the SW 

and FW versions and changes to previous releases. 

Notes 
On certain sections of the manual, when important information or notification is given, text 

is formatted as follows. Please read these notes carefully. 

Note This text is an important note 
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 INTRODUCTION 

Product Description 
UCD-424 is a high speed, USB 3.0 connected video interface test unit. UCD Console is the 

common graphical user interface (GUI) for Unigraf’s UCD-400 and UCD-300 family units. 

The outlook and details of UCD Console will be different depending on the capabilities of 

the connected unit reflecting the features enabled.  

UCD-424 units feature a high-level Software Development Kit (SDK) for use in automated 

testing. It is called Test Software Interface (TSI). TSI allows for an easy integration of 

Production and R&D testing routines into an automated test system environment. Please 

refer to TSI documentation found in additional Unigraf manuals for more details. 

Product Features 

• High resolution video and audio capture up to 8K 30 Hz, 4K / UHD 120 Hz 

• Supports HBR3 feature of DP 1.4a 

• Compatible with HDCP versions 1.3 and 2.3 

• 2 GB on-board high-speed video buffer 

• High speed USB 3.0 host PC interface 

 

Please refer to Product Specifications in the appendix of this document for details. 

 

Functional Description 

UCD-424 units consist of a multimedia signal input stage, an internal pattern generator, a 

control stage with on-board frame buffer and a PC interface stage. In the Input Stage the 

signal is conditioned and converted to desired format. The Interface and Control stages are 

either passing the captured data directly to the USB interface or storing it to the frame 

buffer. The internal pattern generator is able to source a signal for testing sink and branch 

units. The Interface & Control stages are receiving instructions from the host PC to 

configure and control the functionality of the unit. 

Please find below logical diagram of UCD-424 unit. 
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UCD-424 

The image below indicates the connections in UCD-424 unit and their description. 

Name Description 

USB-C DP Tx USB-C connection with DisplayPort™ 1.4a Alt Mode upstream 
Source capability 

USB-C DP Rx USB-C connection with DisplayPort™ 1.4a Alt Mode upstream 
Sink capability 

USB USB 3.0 connection to the host PC 

Power in +12 Vdc Power Supply Input 

Power On/Off Rocker power switch 

Programmer Optional USB interface for configuring the device FW (behind a 
cover) (Not used by default) 

Ethernet Optional Ethernet interface for updating the device FW (behind 
a cover) (Not used by default) 

 

Note Capturing and sourcing high resolution video modes, especially 4K and 8K video 

modes and the 120 Hz frame rate set stringent requirements on the video cables and 

connectors.  

 

Warning In order to avoid damage to the unit and the PC, please always attach the power 

cord (Power In) to the unit first, and after that connect the USB cable to the PC. 
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Unpacking 
The UCD-424 product shipment contains: 

• The UCD-424 unit 

• AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)  

• USB 3.0 compliant cable for host PC connection 

• USB-C to USB-C USB 3.2 Gen2 e-marked cable 
• USB-C to DP Bi-directional Cable for testing DP sinks or sources 

Installation Package 
The UCD-424 software installation package can be obtained from Unigraf download page 

at https://www.unigraf.fi/downloads/.  

The installation package is a bundle between the components needed for UCD Console and 

for TSI SDK. The bundle contains the following items: 

• Windows drivers (installed during set up)  

• UCD Console software GUI (installed during set up) 

• License Manager (installed during set up) 

• DSC Test Content and DSC compression tools (optionally installed during set up) 

• TSI SDK (optionally installed during set up) 

• User Manuals including this document. 

In some cases, also the firmware of the unit needs to be updated. If in doubt, please contact 

Unigraf. 

Note: The software should be installed before connecting the UCD-424 unit in the PC. 

 

Note: System administrator's privileges are required for performing the installation. 

Software Installation 
 Start the installation by running Unigraf Software Bundle Setup.exe 

Once the installer has started, a welcome page is displayed. Welcome page shows the 

software package release version. 

 Click Next to continue. In the next dialog the user needs to agree to Unigraf Software End 

User License and select the components installed. 

Note: Please note that the size of the DSC Source Bitmap Files is 2.6 Gbytes, and that the 

size of the generated DSC Content Library may exceed 200 Gbytes 

 Next dialogs define the installation folder in your PC and the Start Menu folder used.  

 When the selections are ready, click Install to start the installation. 

 Click Finish to exit the installation dialog. 

https://www.unigraf.fi/downloads/
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 LICENSE MANAGER 

Licensing 
The features of UCD Console GUI are divided into groups based on the target use of the 

device. Some basic features can be used without licenses. Advanced feature groups have 

their dedicated licenses that open the related part of the GUI or enable the related control. 

Unigraf licenses are provided as strings of characters, License Keys. Each License Key 

enables a dedicated function in one device. Each device has its dedicated Seed Number. 

Each License Key is tied to one Seed Number. License Keys can be freely used in any 

number of PCs 

License keys are managed with Unigraf License Manager. By default, shortcut to Unigraf 

License Manager can be found in Start Menu. 

Please click Yes in the first dialog. License Manager can be run only with Administrator 

rights. 

Note: System administrator's privileges are required for accessing the licenses. 

License Manager GUI 

When run, License Manager will list the licensing enabled Unigraf devices. If no suitable 

device families are detected, License Manager will exit. Please first select one of the 

available device families by clicking one of the device family selector buttons. 

In the list of Attached Devices please select the device in question. The serial number and 

the seed number of your device are printed in a sticker attached to the bottom of the device. 

The Back button opens the device family selection screen. The Refresh button will re-scan 

the system for installed hardware. 
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Managing Licenses 

Seed Number 

Each license is tied to a hardware unit with the help of the Seed Number. Each unit has a 

unique Seed Number. Seed Number of the selected unit can be found in the top of the 

dialog. 

Seed Number of the selected device can be copied from dialog link for e.g., ordering 

Licenses. 

Adding New License Keys 

To add a new license key for a device, please enter the characters from the license sticker to 

the boxes provided. The License Manager will automatically move the caret across the edit 

boxes during typing. If the key is given in text format, copy it and paste to the leftmost box. 

Once the license key is fully entered, click the Install. The license is authenticated and if it 

is valid, the license will appear in the list of installed licenses. If the key fails to 

authenticate, an error message is displayed. If this happens, please make sure that the key 

has been typed correctly and that the seed number on the license key sticker matches the 

seed number displayed seed number for the device. 

Please note that to avoid confusion, some letters will never appear in a license key because 

they resemble numbers: For example, capital 'G' and number '6' are very similar when 

printed with small font. When in doubt, use numbers. 

Also, please notice, that characters that can't be part of valid license key are not accepted as 

input. When appropriate an automatic conversion is applied while typing: For example, 

lower case letters are converted to upper case automatically. 

Managing Installed Licenses 

The Installed licenses list shows all currently installed licenses for the currently selected 

device. The list shows the actual license key, and what that key unlocks. 

Remove Selected will uninstall selected licenses. To uninstall a license, click on the license 

and then click the Remove Selected button. 

Export will allow all installed licenses for the currently selected device to be saved into an 

INI file for backup and distribution to other PCs. To export a license, click on the license 

and then click the Export button. Please notice that licenses from multiple devices can be 

exported into the same INI file. 

Import will install licenses from an INI file for the currently selected device. 
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 FIRMWARE UPDATE 

UCD Configuration Utility is used to load an updated firmware to the device.  

Note: Firmware update is a sensitive process. Please do not disconnect the device from the 

PC and do not power it off before the operation is completed unless specially 

requested. Avoid plugging and unplugging other USB devices when the firmware 

update is in progress. 

To update the firmware or create a new configuration on a UCD-424 device, please 

perform the following steps: 

 Connect the UCD-424 unit to a power supply and connect the USB cable. 

 Open UCD Console. Select Tools > Firmware update. 

You can launch alternatively UCD Firmware Configuration tool in Start Menu. 

The first page of the utility indicates the firmware component versions present in the 

package. Please click Next. 

 From the list of connected UCD-300 devices please select the one that you want to update. 

Click Next.  



 Firmware Update
  

 13.  

Updated Modules 
The tool indicates the firmware file to be used and prompts for selection of the firmware 

modules to be updated. It compares the modules in the selected device and omits the ones 

that are the same. 

 When you are done, click Next.  

 Power Cycle 

When re-initiating the firmware of a UCD device the whole process cannot be done during 

one session. Therefore, on certain point, user needs to power cycle the device (switch off 

the power > wait for 10 seconds > switch on the power). 

Click OK button on the dialog. 

 

Note:  The procedure may take several minutes depending on the speed of the USB 

connection of the host PC. 
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 UCD CONSOLE 
UCD Console is the graphical user interface (GUI) of UCD-424 for desktop use. It provides 

the user access to all features of the unit. UCD Console also includes powerful debugging 

and analysis tools enabling the user to monitor the status of the display interfaces and assist 

in the problem detection.  

The various features of the UCD-424 are divided into interface specific screens and tabs. 

Each tab contains data and controls for a specific feature.  

Device Selection 
A shortcut of UCD Console can be found by default under Start Menu. Once UCD Console 

GUI is launched the dialog provides a list of UCD devices connected in the PC. Please 

select the target device by clicking on the appropriate button. If your device cannot be 

found in the list, please confirm the power and USB connection to the device and click the 

Rescan … button. 

Select Role 

The use of UCD-424 devices with UCD Console is divided in display interface specific 

roles. The structure of UCD Console varies between roles by having a varying set of tabs 

dedicated to functionalities available in the enabled role. The table below lists the roles and 

tabs available in each role. Please find a detailed description of each role in the later 

chapters of this manual. 
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Warning about DSC Test Content 

When running DSC Compliance Tests, UCD-424 needs to have access to DSC content used 

as test patterns. The content can be created from the source bitmap files downloaded during 

installation (optional) either with Unigraf DSC Content Creator or created by the 

Compliance Test Tool on-the-fly during the compliance test. 

If Automatically create missing content is selected in Tools > Options menu, but the source 

files have not been installed a Warning dialog will open. Clicking OK will open the Option 

menu. 

You can either re-install the whole SW package with DSC Content Library or deselect 

Automatically create missing content in Option menu. 

 

Applying Changes 

In various UCD Console dialogues the user needs to update several parameter or fields to 

make the changes needed. In order to avoid false combinations of parameters the new 

parameters are applied to UCD-424 only after Apply is clicked. In UCD Console the 

situation that parameters have been changed but not applied is indicated by bold values of 

the parameter. 
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Options 
Options can be found in Tools > Options. 

Video Audio and Misc. Options 

Image File Format 

You can save the captured frames either in PPM, BMP or JPG bitmap file format. In PPM 

format the files are stored with the captured color depth, with other formats the color depth 

is truncated to 8 bits per color. 

Audio File Format 

Audio files are stored in WAV format 

Audio Buffer size 

Main buffer: Length of the buffer in the PC memory storing audio samples for monitoring 

audio format in DP RX / Audio tab. Increased buffer length will enable longer time span to 

be monitored. 

Playback buffer: Length in the buffer in the PC for transferring captured audio to PC sound 

system. Increased buffer size will ensure a smooth audio output but will also increase the 

delay between the capture of the audio stream and its playback. 

Folders 

Please select the directories in the PC for saving the captured images and audio, the saved 

Presets 
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DSC 

DSC Work folder: Folder for DSC Work files. 

DSC test content directory: Folder where DSC source bitmap files, related configuration 

files and DSC conversion tools are stored. 

Automatically create missing content: When selected, compliance test tool During 

execution of DSC Compliance Tests, the tool automatically creates the DSC compressed 

content used for testing the DUT. 

Keep auto-created DSC content files: By default, the DSC compressed content is deleted 

after use. If selected, the content is not kept, not deleted. 

Warning Keeping the automatically created DSC compressed content will shorten the time 

needed for running the DSC compliance tests.  

 Please note, that the space needed for storing the full library can be very large 

(appr. 200 GBytes). Please make sure that the content will be stored in a medium 

that has the required space available. 

Misc. options 

Apply color conversions to saved images: When saving captured frames, the Color Mode 

selected in Video tab will be applied also to saved images. 

Bypass 4:2:x –> 4:4:4 conversions: 4:2:2 and 4:2:0 images are previewed and stored as 

received, without pixel doubling. 

HDCP protected monitor: Text appearing if the monitor where UCD Console is viewed is 

HDCP compliant and HDCP is enabled. This feature enables preview of captured HDCP 

encrypted content in Video tab. 

TSI Integration 

Selections for generating a workspace for TSI usage. 

Enable TSI Integration: When selected, TSI Integration tool (Tools > TSI Integration) is 

enabled. When exporting test parameters in Sink / Source DUT Testing, test code is also 

appended for execution with TSI. 

Please refer to TSI Integration and Exporting Tests for TSI later in this document. 

AUX Analyzer Options 

Options for configuring the way data is presented in AUX Analyzer tab in Event Log.  

Please find full description of the controls in chapter Event Log / DP AUX Analyzer later in 

this document. 



 UCD Console
  

 18.  

TSI Integration 
Tools > TSI Integration. Selections for generating a workspace for TSI usage. 

TSI Integration enables automatic creation of the necessary configuration files for 

executing tests exported from UCD Console’s Sink DUT testing or Source DUT Testing. 

Please refer to chapters Source DUT Testing Tab and Sink DUT Testing Tab later in this 

document for description about exporting tests. 

Detaching Tabs 
Most of the UCD Console tabs can be detached into a separate window for monitoring and 

controlling separate features simultaneously. To detach a tab Right-click on a tab and 

select Detach Page. To glue the tab back to the main window, click on the red Close 

button in the top right-hand corner of the window or press <Alt> + F4 on the keyboard. 
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 DISPLAYPORT ALT MODE 
REFERENCE SINK 

DisplayPort Alternate Mode Reference Sink function uses USB-C DP Rx interface. 

DisplayPort Alternate Mode Reference Sink dialog is selected from the vertical tab  

(DP RX) on the left edge of UCD Console. Horizontal tabs on top of the GUI open controls 

for the various functions available for the interface. Some of the tabs are enabled by 

default, some only when an applicable license is included. DP RX contains the following 

functions. 

• USB-C Monitoring dialog (USB-C) 

• Video preview and saving (Video) 

• Audio monitoring and saving (Audio) 

• Status information and control of the upstream link (Link) 

• EDID editor (EDID) 

• DPCD editor (DPCD) 

• HDCP status monitor and control (HDCP) 

• SDP sent by the Source device (SDP) 

• DSC capability control (DSC) 

• FEC feature control and status (FEC) 

• Source DUT Testing. 
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USB-C Monitoring 
In USB-C Monitoring dialog operator can evaluate the status of the USB-C connection, the 

various roles adopted, and the configuration of the DP Alternate Mode. The user can set the 

initial roles for the UCD-424 TE and the optional capabilities for UCD-424 in the USB-C 

PD Contract. Controls allow user also to swap Power and Data roles. USB-C related panel 

can be selected from the USB-C tab on top of the GUI. 

 

USB-C Monitoring dialog contains two horizontal tabs 

• Roles and Modes 

• Edit PDO Information 

• Cable Info 

 

Roles and Modes Sub-Tab 

The Roles and Modes tab is divided into two parts: the left side is the Status panel while 

the right side provides the Configuration dialogs. 

Status 

The status panel lists the various roles and statuses of UCD-424 after the connection 

negotiation with the USB-C DUT.  

The uppermost group indicates the general statuses like Power Role and Data Role 

DP Alt Mode Configuration. 

Fixed Supply PDO (Power Data Objects) lists the PD status settings for the connection 

party acting as Source Port (in the shown case UCD-424). 

Contract RDO (Request Data Objects) lists the PD status settings for the connection party 

acting as Sink Port. 

The lowermost group lists the actual measured values of the Vbus, CC lines and Vconn. 
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Configuration 

Initial Port Role: Defines the role which UCD-424 presents itself in the start of PD 

communication (both power and data role). 

DP Alt Mode (DFP) 

Auto enter on connect: Start mode discovery after connection and enter DP Alternate mode 

if suitable configuration is found. 

Manual: 

4 lanes (C,E): Restart mode discovery and advertise support for modes C and D  

(4 DP lanes). 

2 lanes (D): Restart mode discovery and advertise support for mode D  

(2 DP lanes + USB SS). 

Exit: Exit DP Alternate mode. 

DP Alt Mode Capabilities (UFP_D) 

Supported Pin Assignments declared in DisplayPort Capabilities discover message. 

DP Alt Mode 4 lane (C): All 4 lanes reserved for DP Alt Mode 

DP Alt Mode 2 lane (D): 2 lanes reserved for DP Alt Mode 2 lanes for USB SS 

DP Alt Mode 4 lane (E): All 4 lanes reserved for DP Alt Mode. Pin assignment E for 

supporting USB-C to DP cables and adapters. 

Multi-function preferred: When entering DP Alternate Mode, select mode D. 

Swap 

The Swap buttons allows the user to request a swap of either Data role, Power role or the 

CC line where VCONN is applied. 

VCONN: Send VCONN_Swap message to request an exchange of Vconn Source. 

Power role: Send PR_Swap message to request an exchange of power roles. 

Data role: Send DR_Swap message to request an exchange DFP and UFP operation 

between Port Partners while maintaining the direction of power flow over Vbus. 

Prevent DUT Swap Requests  

When selected the corresponding Swap messages from DUT are ignored. 
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Accessories 

Audio Accessory: Enable simulation of Audio Accessory support 

Debug Accessory: Enable simulation of Debug Accessory support 

Enabling Audio Accessory and Debug Accessory extends USB Type-C Connection State 

Machine with *.Accessory states. (Please refer to USB Type-C specification for details). 

Note: Please note that UCD-424 does not support any physical connections for the 

Accessory functions. The selections enable only behavioural simulation. 

Bottom Panel 

The control lights indicate presence of the USB-C connection (Plugged, Not Plugged), the 

type of cable (Passive, Active/E-marked, Unigraf electrical test cable) and Cable 

Orientation (Straight, Flipped). 

With the button you can Reconnect the USB-C connection. 
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Edit PDO Information Sub-Tab 

The Edit PDO Information tab is divided into two sub-tabs: PD Source objects and 

PD Sink objects. Both panels allow user to set the PD Contract parameters of UCD-424 TE. 

Apply: Write the selections to UCD-424 registers. 

Refresh: Update the dialog by reading UCD-424 registers. 

Note: Please note that changes will be written to the UCD-424 registers only by clicking 

Apply. 
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Cable Info Sub-Tab 

The Cable Info tab displays the information received from the cable as a response to 

Discover Identity command sent to SOP’. 

Click Refresh to read the data from an electrically marked cable. 
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Video Tab 
Video tab is the Preview window for the captured DisplayPort stream. 

Input video mode 

 

The measured input resolution, frame rate and color format are shown below the preview 

window. The indication of the number of frames captured to the PC indicates the pace of 

the image data transfer to the PC. 

Disable / Enable Preview 

Click here the button to start or stop capturing video frames. 
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The top ribbon of the tab has the following controls: 

Color Mode for preview 

 

• No Conversion: The captured color components are interpreted as R, G and B 

respectively. No color conversion will be done. 

• Automatic: The color mode is selected based on the information in the MSA. If there 

is no color information available, “No Conversion” is used. 

• YCbCr (ITU-709) - > RGB: The captured data components are interpreted as Y, Cb, 

and Cr respectively. Color conversion to RGB is done based on ITU-709 standard. 

• SMPTE 170M - > RGB: The captured data components are interpreted as Y, U, and 

V respectively. Color conversion to RGB is done based on SMPTE 170M standard. 

Note: Please note that the color mode selection applies to the preview window only. All 

internal functions use the raw image data as captured from the input channel. 

Select Virtual Channel 

When Multistreaming (MST) is enabled, the monitored stream can be selected here. 

Save one frame 

 

Capture and save one video frame as a bitmap file in the PC. The format and storage 

location can be selected in Tools > Options pull-down menu. The available bitmap formats 

are PPM, BMP and JPG. 

The selections in Tools > Options menu define if the frame bitmap will be stored as 

captured from the display interface or if the color mode conversion selected for preview 

will be applied. 

Sequence recording 

 

Clicking the button opens a dialog for definition of number of frames recorded. Buffered 

mode can also be enabled in this dialog. 

In buffered mode, all input frames are captured non-drop until the on-board frame buffer 

will be full. The dialog also informs the capacity of the buffer with the selected video 

mode. 

In non-buffered mode, only one input frame is buffered at a time. Frames will be skipped if 

the transfer of the data to the PC is slower than the input data rate. 

Note: Please note that buffered mode cannot be used when Audio preview is enabled. 
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Snap preview 

 

When clicked, one frame of the incoming video is captured and shown in a new Snapshot 

tab. The captured bitmap can be saved with Save one frame function described above. 

Color Information of the Captured Bitmap can be evaluated by placing the mouse cursor 

on top of the preview image. The lower right-hand side ribbon of the GUI lists 

• Location of the cross cursor on the bitmap 

• The intensity of the Red, Green and Blue components of the pixel on the cursor 

location 

• The HTML HEX color code of the pixel on cursor location 

Zoom of the Preview Image can be altered by right clicking on top of the preview image 

and selecting between 

• Fit Window 

• Zoom 25% 

• Zoom 50% 

• Zoom 100% 

• Zoom 200% 

• Zoom 500% 

While in the Snap preview mode clicking on the “Camera” icon will take additional 

snapshots 
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Preview DSC Decompressed Stream 

In order to capture and preview DSC compressed video DSC must be enabled by selecting 

Link Configuration > Other Capabilities > DSC checkbox in Link tab. 

Select Enable Preview to verify that DSC compressed stream is received. 

Click Snap a Frame button to capture one frame and start the decompressor (offline in the 

PC). Once the decompression is ready, the frame is shown, and DSC Log lists the details of 

the compressed image. 
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Audio Tab 
Audio tab has a preview of the audio signal format and the controls for audio playback and 

recording. Up to eight channels will be shown based on the received audio stream. 

The audio signal format is shown in three ways 

• The ‘oscilloscope’ panel displays the waveforms of the received audio channels.  

• The frequency spectrum of the audio is shown in the lower panel. The range of the 

spectrum display is from 0 to 1/2 of the input sampling rate. The amplitude scale of 

the spectrum display can be selected between ‘Linear’ to 80 dB. 

• The horizontal sound level indicator is in the bottom of the dialog.  

The span of the preview window is defined with Audio preview size found in Tools > 

Options dialog. The value is given in ksamples (1024 samples). The relation between the 

preview window span in milliseconds (msec) and the value given in Audio preview size 

depends on the sampling frequency. Please do not exceed the Audio buffer size set in the 

same dialog. 

Disable / Enable Preview 

This button controls capturing the audio data. 

Select Virtual Channel 

When Multistreaming (MST) is enabled, the monitored stream can be selected here. 
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Playback device selection 

The captured audio can be played back in the PC. The combo-box defines the audio device 

in the host PC through which the captured audio is played. By default, the No audio 

playback is chosen. 

Note Please note that the audio capabilities of the audio playback device of the PC are not 

automatically reflected in the audio capabilities description in UCD-424 EDID. 

Since UCD-424 is not performing any audio format conversion, it might occur that 

the source provides an audio format that the selected playback device is not 

supporting. In case a conflict occurs, please change manually the EDID content or 

disable audio playback to monitor the waveforms in UCD Console. 

Refresh audio device list 

 

Click here to re-read the list of audio devices after making changes to the host PC 

configuration. 

Audio Buffer Size 

The amount of buffering used in the data transfer between the UCD-424 unit and the PC in 

Audio buffer size in Tools > Options dialog. Increased buffer size will ensure a smooth 

audio output but will also increase the delay between the capture of the audio stream and its 

playback. 

Start audio recording 

 

The captured audio can be recorded in the PC using Waveform Audio File Format, WAV 

(*.wav) format. The pop-up dialog defines recording duration. The folder where the audio 

file will be saved can be selected in File > Options. 

Input audio mode 

 

This field (in the bottom of the dialog) indicates detected audio mode in the input stream. 
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Link Tab 
Link tab contains four panels: Cable / HPD, Link Status, Link Configuration and Stream 

Status. 

Cable / HPD 

Indicator lights of the state of the cable. Cable indicates that the hardware has detected an 

upstream cable. HPD indicates that the HPD signal is Asserted (logical “high”). 

Clicking the Deassert button will cause HPD line to be set to logical “low” (de-asserted) 

and hence no HPD pulse can be generated. Click the Assert to re-activate the HPD line (set 

to logical “high”). 

To apply an HPD Pulse with programmable duration click Pulse HPD. The duration will 

be defined in the provided field. 

For applying a short pulse click Short Pulse. Pulse duration is 1 ms. 

Link Status 

Link Status displays the status of the link training and the link parameters negotiated 

between UCD-424 Sink and the Upstream Source. The data is retrieved from the DPCD 

registers of the UCD-424 Sink. The status is updated automatically.  

Link Configuration 

Link Configuration allows the user to change the way the Sink capabilities are announced 

in the DPCD registers of the UCD-424 Sink. Maximum Lane Count and Maximum Link 

Rate are set with their appropriate radio buttons. To update the new status to the DPCD 

registers click Apply. 

Other Capabilities section includes controls of features like MST, FEC and DSC 

When Force cable status to plugged is checked, sink functionality is active regardless of a 

failure of upstream device detection e.g. due to incorrect AUX Channel electrical 

termination. 

Click Enable Fast LT to enable support for a link training without AUX transactions. 
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To apply a Hot-Plug Detect pulse automatically after updating the status, select Generate 

HPD pulse on Apply. HPD pulse duration will be defined in the Pulse HPD field. 

Stream Status 

Stream status is enabled with UCD Pro for DP Sink license. 

Video Timing Details are retrieved from the Main-Stream Attributes (MSA) of the 

monitored stream. Frame rate is measured by UCD-424 Local Sink.  

Note: Please note that the MSA information used for Video Timing Details is provided by 

the Upstream Source, it is not measured by the UCD-424 Local Sink. 

CRC 

The 16-bit CRC (checksum, cyclic redundancy check) values of the three color 

components calculated by the Sink hardware. To re-calculate, click Update Link Status. 

The 16-bit DSC CRC values of the captured DSC compressed frame. “Value 0” is 

calculated from 1st, 4th, 7th … byte, “Value 1” from 2nd, 5th, 8th … byte and “Value 2” from 

3rd, 6th, 9th … byte. 

Multistreaming 

When Multistreaming (MST) is enabled, and the source sends a multi-stream signal the 

details of the received virtual channels is shown in a table in Stream Status field. 

Port#: Port number where the virtual channel is directed. 

Stream ID: Stream identification number of the virtual channel 

Req. PBN: Requested PBN (payload Bandwith Number) value for the virtual channel 

Alloc.PBN: PBN value allocated for the virtual channel 

First slot: Time slot where the first VC Payload for the virtual channel is stored 

Slot number: Number of VC Payload slots reserved for the virtual channel. 
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EDID Tab 
EDID Tab provides tools for accessing the EDID of the UCD-424 Sink presented to the 

Upstream Source Device. There are three basic functions: 

• Load and save EDID data files in the host PC 

• Edit the EDID contents 

• Program and read the contents of the EDID memory of up to four virtual MST Ports 

EDID Files 

With Load… and Save as… a hex EDID file can be read and written from the PC. Please 

note that the program does not alter the contents of the EDID file or verify its integrity 

during load and save operation. 

Note Four blocks (512 bytes) of EDID code is read. If the device is not supporting all 

four blocks, the non-supported area is replaced with zeroes. 

 Currently the EDID Editor does not support Display ID. Hex EDID files can 

however be modified with the HEX Editor or externally generated hex EDID files 

that have Display ID content can be load and programmed into the hardware. 

HEX Editor 

When EDID content is either loaded from a file or read from the hardware EDID memory, 

it is shown in the EDID Data panel on the left hand side of the dialog. EDID contents can 

be edited by typing over the existing values. Altered content is highlighted with RED. 

Please note that Hex Editor itself does not alter the contents of the EDID data or verify its 

integrity. 

After editing the data can either be saved to an *.ecd file in the PC with Save as… or 

programmed it to the hardware EDID memory with Write. 
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EDID Editor 

EDID Editor is launched in a separate pop-up window. Please see the description of the 

EDID editor in Chapter EDID Editor later in this document. 
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the UCD-424 Sink. 

The tool consists of two independent monitoring and editing windows for the DPCD data. 

The user can freely select the the DPCD address areas shown on each panel.  

The DPCD Decoder panel on the right hand side shows the interpretation of the DPCD 

byte selected on the monitoring windows. The selected byte is shown with a green outline.  

The combo box above the DPCD Decoder window allows selection of how the DPCD data 

is interpreted. It can be either as DP 1.4 DPCD, or as DP 1.4 DPCD with Detailed 

Capability Info selected or not (DETAILED_CAP_INFO_AVAIL = 1/0). 

Click Refresh to re-read the data from the DPCD registers to the window in question.  

Click Write Changes to write the portion of data shown in the window in question to the 

DPCD registers. 

Click Set Reference to store currently shown data as a reference for comparison.  
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When the data is Refreshed from the DPCD registers the changed bytes will be highlighted 

with gray background. 

The fields edited by the user will be highligted with red color. 

Saving and Loading DPCD Content 

DPCD data in the selected address areas can be saved as a file in your PC. There are three 

alternative formats: 

• Binary DPCD Fata File format (*.DPD). This is Unigraf proprietary format. You can 

also load the DPCD content stored in this format. 

• Comma Separated Values (*.CSV) for loading the data to a spreadsheet. 

• HEX Dump (*.HEX) in a human readable text format. 

 Click Save to select the location and the format of the file.  

 Click Load to load DPCD data saved in DPCD Data File (*.DPD) format to the editor.  

 To program the data into the DPCD registers of UCD-424 Local Sink click Write 

Changes. 

Note - Writing DPCD data to the DPCD registers of the UCD-424 Local Sink will 

potentially affect the status and capabilities of UCD-424 as seen by the upstream 

source. 

- User control like Link Training or mode changes will modify the content of the 

DPCD registers 

- During a reboot of UCD-424 the DPCD registers will be returned to their default 

values 
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HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwidth Digital Content 

Protection) status and controlling the HDCP capabilities of the UCD-424 device. 

Status 

The status field indicates the HDCP status of the UCD-424 device. 

Active: The link between UCD-424 and the upstream source has been encrypted. 

Authenticated: The HDCP handshake between the UCD-424 and the sink unit has been 

completed successfully. 

Declared as HDCP capable: The UCD-424 unit recognizes HDCP handshake messages. 

Keys loaded: The HDCP keys are loaded to the UCD-424 unit. 

Configuration 

HDCP Capable: To disable HDCP uncheck the box. 

Keys 

Select between Production or Facsimile HDCP keys. To remove the keys, select None.  

HDCP 1.3 vs. HDCP 2.3 

UCD-424 devices support by default both HDCP 1.3 and HDCP 2.3 standard. 



 DisplayPort Alt Mode Reference Sink
  

 38.  

SDP Tab 
SDP Tab is enabled with UCD Pro for DP Sink license. 

In SDP Tab shows the Secondary-Data Packets sent by the Source device. Click Update to 

re-read the data. 

SDP Tab displays in hexadecimal format the following received SDP packets: 

• Audio_TimeStamp 

• Audio_Stream 

• Extension 

• Audio_CopyManagement 

• ISRC 

• Video Stream Configuration (VSC) 

• Camera Generic 0 

• Camera Generic 1 

• Camera Generic 2 

• Camera Generic 3 

• Camera Generic 4 

• Camera Generic 5 

• Camera Generic 6 

• Camera Generic 7 

• Vendor-Specific Infoframe packet 

• AVI InfoFrame packet 

• Source Product Descriptor InfoFrame packet 

• Audio InfoFrame packet 

• MPEG Source InfoFrame packet 

• Dynamic Range and Mastering InfoFrame 

• Picture Parameter Set (PPS) 

 



 DisplayPort Alt Mode Reference Sink
  

 39.  

DSC Tab 
DSC Tab is enabled with DSC Decoder license. 

DSC tab contains control of the Display Stream Compression (DSC) feature, and definition 

of DSC support capabilities that UCD-424 defines in its DPCD register. 

Enabling DSC 

Enabling DSC feature is controlled by the connected source device. When connected, a 

source verifies corresponding registers in DPCD (0x00060) of UCD-424 sink to find out if 

DSC capability is declared.  

DSC Capable: Control of UCD-424 DPCD register 0x00060 bit 0. Please click Apply to 

enable the change. 

DSC Enabled: Connected source has enabled DSC 

DSC Support Capabilities 

The various controls in this tab change the content of UCD-424 sink DPCD register address 

range (0x00061 through 0x0006F) related to DSC. Please click Apply to enable the change. 

Apply 

Write changes to UCD-424 sink DPCD registers 

Refresh 

Re-read the content of UCD-424 sink DPCD and update the control status. 

Reset Defaults 

Reset the content of UCD-424 DSC related DPCD registers (0x00060 through 0x0006F) to 

the default values as defined in UCD-424 firmware. 
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FEC Tab 
FEC Tab is enabled as a basic feature. 

FEC tab contains control of the FEC (Forward Error Correction) feature, Error Detection 

table and FEC Status Log. 

Enabling FEC 

Enabling FEC feature is controlled by the source device. When connected, source verifies 

corresponding registers in sink DPCD to find out if sink is FEC capable. This register in 

UCD-424 sink can be controlled by FEC Capable checkbox. 

Since source normally polls sink DPCD mainly after a new connection, selecting Generate 

HPD on change will force a new connection after the change of the FEC capability status. 

 Click Update to read the FEC Error Counters 

 Click Clear to clear the counters. 

FEC Status Log lists FEC events. 
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Source DUT Testing Tab 
Please refer to Appendix E later in this document for description of the tests available. 

Select the tests for execution by clicking the corresponding row. 

Clicking Configure… opens a dialog for defining the test parameters for that set. Please 

refer to Test Parameters below for description. 

Parameters from Test descriptor files can be loaded with Import and stored with Export. 

Please refer to chapter Exporting Tests for TSI later in this document. 

 Tests are started by clicking Run Selected. By clicking Abort the sequence is stopped. 

Test flow can be controlled with Repeats of the test sequence, Delay time between 

individual tests or Stop on Failure that stops the whole sequence if one of the tests fail. 

At the completion of each test the result of the test is indicated in the matrix on the right 

hand side of the test panel. For each test, the matrix lists the number of occurrences of each 

result and the number of tries performed. 

Click Save Report to generate a HTML report file for sharing the results with other parties 

for viewing without UCD Console. 

By clicking Clear All the test log and the results matrix are cleared. 
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Test Parameters 

Each test set has its dedicated set of test parameters. Open a dialog for defining the 

parameters by clicking Configure…. 

Parameters of Link Layer CTS 

Link Layer CTS parameters includes DUT capabilities defined in Source Device Capability 

Question List in document DisplayPort Link Layer Compliance Test Specification. The 

capabilities are grouped into tabs based on the tested feature. 

Parameters of HDCP CTS 
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Parameters of CRC Test Set 

CRC Video test parameters dialog contains fields for defining the test duration, number of 

frames captured, errors allowed and expected video format. 

Click Capture now to record Reference CRCs. Please define the number of frames used as 

reference – either one or the number of frames in the predefined test sequence.  

Parameters of DP RX Simple LT Tests 

The parameters for DP RX Simple LT test set is a subset of DUT capabilities. 

Presets 

In all parameter dialogs the selected parameters can be saved as Presets. Please click 

Presets… to save or recall a configuration.  



 DisplayPort Alt Mode Reference Sink
  

 44.  

Exporting Tests for TSI 

Unigraf UCD Console includes a feature rich Software Development Kit (SDK) for use in 

automated testing. The SDK is called Test Software Interface (TSI). TSI allows for an easy 

integration of Production and R&D testing routines into an automated test system 

environment. Please refer to TSI documentation found in additional Unigraf manuals for 

details. 

The tests included in UCD Console’s Source DUT Testing tab and Sink DUT Testing tab 

can be executed in TSI environment. A straightforward way is to use UCD Console’s 

Tools > TSI Integration dialog to create the necessary files for TSI environment and use 

Export function in DUT Testing tabs to include the intended tests. 

Export: Save parameters of the selected test to a file. If TSI Integration is enabled in  

Tools > Options, also the test is appended into ‘Run Test’ file in TSI workspace folder. 

Import: Recall parameters from configuration file. If TSI Integration is enabled in Tools > 

Options, parameters are imported from a file in TSI workspace folder 
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 DISPLAYPORT ALT MODE 
REFERENCE SOURCE 

DP Reference Source function is using one output channel, DisplayPort Source (DP TX). 

The corresponding vertical tab can be seen on the left edge of the GUI.  

The horizontal tabs on the top of the GUI enable the various functions available for the 

output channel. Some of the tabs are enabled by default, some only when an applicable 

license is included. DPTX features the following functions. 

• USB-C Monitoring 

• Video pattern generator (Pattern Generator) 

• Audio generator (Audio Generator) 

• Status information and control of the downstream link (Link) 

• EDID editor (EDID) 

• DPCD monitor (DPCD) 

• HDCP status monitor and control (HDCP) 

• FEC feature control and status (FEC) 

• Sink DUT Testing Tab. 

USB-C Monitoring 
In USB-C Monitoring dialog operator can evaluate the status of the USB-C connection, the 

various roles adopted, and the configuration of the DP Alternate Mode. The user can set the 

initial roles for the UCD-424 TE and the optional capabilities for UCD-424 in the USB-C 

PD Contract. Controls allow user also to swap Power and Data roles. USB-C related panel 

can be selected from the USB-C tab on top of the GUI. 

 

USB-C Monitoring dialog contains two horizontal tabs 

• Roles and Modes 

• Cable Info 
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Roles and Modes Sub-Tab 

The Roles and Modes tab is divided into two parts: the left side is the Status panel while 

the right side provides the Configuration dialogs. 

 

 
 

Status 

The status panel lists the various roles and statuses of UCD-424 after the connection 

negotiation with the USB-C DUT.  

The uppermost group indicates the general statuses like Power Role and Data Role 

DP Alt Mode Configuration. 

Fixed Supply PDO (Power Data Objects) lists the PD status settings for the connection 

party acting as Source Port (in the shown case UCD-424). 

Contract RDO (Request Data Objects) lists the PD status settings for the connection party 

acting as Sink Port. 

The lowermost group lists the actual measured values of the Vbus, CC lines and Vconn. 

Configuration 

Initial Port Role: Defines the role which UCD-340 presents itself in the start of PD 

communication (both power and data role). 
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DP Alt Mode (UFP) 

Auto enter on connect: Start mode discovery after connection and enter DP Alternate mode 

if suitable configuration is found. 

Manual: 

4 lanes (C,E): Restart mode discovery and advertise support for modes C and D  

(4 DP lanes). 

2 lanes (D): Restart mode discovery and advertise support for mode D  

(2 DP lanes + USB SS). 

Exit: Exit DP Alternate mode. 

DP Alt Mode Capabilities (DFP_D) 

Supported Pin Assignments declared in DisplayPort Capabilities discover message. 

DP Alt Mode 4 lane (C): All 4 lanes reserved for DP Alt Mode 

DP Alt Mode 2 lane (D): 2 lanes reserved for DP Alt Mode 2 lanes for USB SS 

DP Alt Mode 4 lane (E): All 4 lanes reserved for DP Alt Mode. Pin assignment E for 

supporting USB-C to DP cables and adapters. 

Swap 

The Swap buttons allows the user to request a swap of either Data role, Power role or the 

CC line where VCONN is applied. 

Data role: Send DR_Swap message to request an exchange DFP and UFP operation 

between Port Partners while maintaining the direction of power flow over Vbus. 

Power role: Send PR_Swap message to request an exchange of power roles. 

VCONN: Send VCONN_Swap message to request an exchange of Vconn Source. 

Prevent DUT Swap requests  

When selected the corresponding Swap messages from DUT are ignored. 

Bottom Panel 

The control lights indicate presence of the USB-C connection (Plugged, Not Plugged), the 

type of cable (Passive, Active/E-marked, Unigraf electrical test cable) and Cable 

Orientation (Straight, Flipped). 

With the button you can Reconnect the USB-C connection. 
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Edit PDO Information Sub-Tab 

The Edit PDO Information tab is divided into two sub-tabs: PD Source objects and 

PD Sink objects. Both panels allow user to set the PD Contract parameters of UCD-424 TE. 
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Cable Info Sub-Tab 

The Cable Info tab displays the information received from the cable as a response to 

Discover Identity command sent to SOP’. 

Click Refresh to read the data from an electrically marked cable. 

Note Please note that only the port partner that is DFP mode communicates with the cable 

plug. Therefore, Cable Info is available only in DFP mode. 
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Pattern Generator Tab 

 

Note The video modes that can be used in MST streams are limited by the overall 

capability of the DisplayPort link and the capability of the connected DisplayPort 

Sink or Branch device.  

Predefined Timings 

UCD-424 includes a set of common predefined video timings. Please find a list of the 

timings with their major details in Appendix C of this document. 

Color Mode 

RGB color mode with full range quantization levels will be used with all patterns except 

with Color Square Pattern. This pattern allows the user to select RGB, YCbCr 4:4:4, 

YCbCr 4:2:2 and YCbCr 4:2:0 color modes. When YCbCr is selected, the Colorimetry 

dropdown box is enabled and allows selection between ITU-709 and ITU-601. Please find a 

description of the available test patterns in Appendix D of this document. 

Color Depth 

You can set the color depth used. The available color depths are: 6, 8, 10, 12 and 16 bpc. 

Color depth 6 bpc is only available with RGB. 

Predefined Video Patterns 

UCD-424 has a set of predefined patterns and a possibility to user defined custom pattern. 

You can select the pattern in the provided combo box. By selecting Disabled you can have 

the links activated but no video data transferred. 

Please find a description of the available test patterns in Appendix D of this document. 

When MST mode is selected, full selection of test patterns is available only in stream 0 
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Custom Image Patterns 

BMP, PNG, JPG and TIFF files can be loaded from the PC to be used as custom images. 

The bitmaps will be aligned to the top left hand side corner, displayed at the original 

resolution, no scaling, cropped to the active area. 

MST Operation 

Multi-streaming can be enabled from MST check box and selecting the number of streams. 

 

Note Please note that MST and DSC features and cannot be used simultaneously 

Pattern Generator Settings 

In order to avoid sourcing invalid video mode combinations new settings are being 

validated when the user is clicking Apply. Automatic validation will be applied when 

Auto-apply when valid is checked. The situation that parameters have been changed but 

not applied is indicated by bold values of the parameter. If new settings cannot be 

supported by e.g. the selected link configuration, an error dialog will be shown. 

Note Please note that the changes in Pattern Generator tab will not be applied unless the 

user validates them by clicking Apply or when Auto-apply when valid is checked. 

Custom Timing 

Custom Timing feature is enabled with UCD Pro for DP Source license. 

The timing parameters can be modified by selecting the Custom check-box and editing the 

fields of the matrix. Enable the new parameters by clicking Apply button. 
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Manage Timings 

Custom timings can also be created and edited with pop-up Timing Editor. Launch the 

editor by clicking Manage Timings. 

 In order to create a new custom timing based on one of the standard fixed, timings select 

the fixed timing and change its name and click Add new timing to store. 

 In order to modify an existing custom timing, select it, modify and click Update timing. 

The dialog will make a sanity check for the values entered and will warn the user for any 

combinations that cannot be used. 

Customize Timings List 

The timings are shown on the pull-down menu by un-checking the Show box. The timings 

will remain in the list and can be brought back to the pull-down menu, when needed. 
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Sourcing DSC Compressed Patterns 

DSC compressed pattern files can be created with a separate tool called DCS Compressor. 

It can be launched from Tools > DSC Compressor. 

 Select the source bitmap file in Source File field. Define the Output Resolution, the color 

depth, compression ratio and number of horizontal and vertical slices in the frame. 

 Click Start Compressor(s). 

A DSC compressed file named e.g. Your_Picture_4096_2160_8.dsc will be created in the 

same folder are your source file Your_Picture. The selected resolution and bit depth will be 

added to the file name. 

 Select Enable DSC and click Apply. 

Note Please note that the output resolution has to match the size of the used compressed 

DSC image. 

 

Note Please note that MST and DSC features and cannot be used simultaneously 
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Audio Generator Tab 
Audio generator allows the user to play LPCM audio generated internally or from files in 

WAV format. 

To load internally generated audio, select Generate audio, and adjust the controls to the 

desired audio format. 

 To load an audio file from your PC, select Load audio from file, click the Open WAV 

file… button, browse and select the file and click Open 

 To play the selected audio content, click the Play  button. 

The content will be looped until the Stop  button is clicked.  

Audio Status in the top of the tab indicates the type of the currently played audio content.  
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Link Tab 
Link tab shows the status and control items for the DisplayPort link. 

HPD 

The status LED indicates the state of the HPD signal Asserted (logical “high”) or De-

asserted (logical “low”). 

Link status 

The panel shows the result of the link training with the connected downstream sink and 

status of connection features. 

Output Level 

Override output level and pre-emphasis values selected during link training. Click Apply 

Overrides to validate changes. 

Note Please note that connected Sink and Source actively maintain the link. If the 

override settings result in link failure, the link will be automatically re-trained and 

proper values set. 

Link configuration 

Set target capabilities for the link training. Click Link Training to apply.  

• Set the Number of Lanes used,  

• Set the maximum Link Rate, 

• Enable Enhanced Framing Mode 

• Enable down spreading of link frequency. 

Allowed amplitude range is 1 to 10‰ (per mil, 0.1%) (DP 1.4a requirement is 0.5% 

maximum) 

Allowed Frequency range is 30 to 35 kHz. (DP 1.4a requirement is 30 to 33 kHz) 

Click Fast LT to initiate a link training without AUX transactions. 
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Link Pattern 

Select between Active video and audio, Idle pattern, or special bit patterns. 

When Force Active Video option is selected, character error messages from sink will not 

interrupt video transmission. 

When Force Idle Pattern is selected, Link Training and Active Video will not be initiated 

even after a replug. 

Note Please note that except Active video, the patterns do not carry video and audio. They 

are special bit combinations used for development purposes. When selecting Active 

Video (or Force Active Video) normal audio and video are being transmitted over 

the link. 

CRC 

The 16-bit CRC (checksum, cyclic redundancy check) values of the three color 

components calculated by the Sink hardware. 

The 16-bit DSC CRC values of the captured DSC compressed frame. “Value 0” is 

calculated from 1st, 4th, 7th … byte, “Value 1” from 2nd, 5th, 8th … byte and “Value 2” from 

3rd, 6th, 9th … byte. 
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EDID Tab 
EDID tab enables analyzing and saving the EDID read from the connected Sink device. 

There are three basic functions: 

• Read the contents of the EDID of the downstream sink over the DisplayPort link.  

• Load and save EDID data files in the host PC 

• Edit the EDID contents 

 

EDID Files 

With Load… and Save as… a hex EDID file can be read and written from the PC. Please 

note that the program does not alter the contents of the EDID file or verify its integrity 

during load and save operation. 

Note Four blocks (512 bytes) of EDID code is read. If the device is not supporting all 

four blocks, the non-supported area is replaced with zeroes. 

 Currently the EDID Editor does not support Display ID. Hex EDID files can 

however be modified with the HEX Editor or externally generated hex EDID files 

that have Display ID content can be load and programmed into the hardware. 

HEX Editor 

When EDID content is either loaded from a file or read from the hardware EDID memory, 

it is shown in the EDID Data panel on the left hand side of the dialog. EDID contents can 

be edited by typing over the existing values. Altered content is highlighted with RED. 

Please note that Hex Editor itself does not alter the contents of the EDID data or verify its 

integrity. 

After editing the data can either be saved to an *.ecd file in the PC with Save as… or 

programmed it to the hardware EDID memory with Write. 
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EDID Editor 

EDID Editor is launched in a separate pop-up window. Please see the description of the 

EDID editor in Chapter EDID Editor later in this document. 
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the connected 

Downstream Sink. 

The tool consists of two independent monitoring and editing windows for the DPCD data. 

The user can freely select the the DPCD address areas shown on each panel.  

The DPCD Decoder panel on the right hand side shows the interpretation of the DPCD 

byte selected on the monitoring windows. The selected byte is shown with a green outline.  

In the combo box above the DPCD Decoder window you can select how the DPCD data is 

interpreted, either as DP 1.1 DPCD, or as DP 1.2 DPCD with Detailed Capability Info 

selected or not (DETAILED_CAP_INFO_AVAIL = 1/0). 

By clicking Refresh you can re-read the data from the DPCD registers to the window in 

question.  

By clicking Write Changes you can write the portion of data shown in the window in 

question to the DPCD registers. 

By clicking Set Reference you can store currently shown data as a reference for 

comparison.  

When you refresh the data from the DPCD registers the changed bytes will be highlighted 

with gray background. 
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The fields edited by the user will be highligted with red color. 

Saving and Loading DPCD Content 

DPCD data in the selected address areas can be saved as a file in your PC. There are three 

alternative formats: 

• Binary DPCD Fata File format (*.DPD). This is Unigraf proprietary format. You can 

also load the DPCD content stored in this format. 

• Comma Separated Values (*.CSV) for loading the data to a spreadsheet. 

• HEX Dump (*.HEX) in a human readable text format. 

 Click Save to select the location and the format of the file.  

 Click Load to load DPCD data saved in DPCD Data File (*.DPD) format to the editor.  

 To program the data into the DPCD registers of UCD-424 Local Sink click Write 

Changes. 

Note - Writing DPCD data to the DPCD registers of the Sink will potentially affect the 

status and capabilities of sink as seen by the source. 

- User control like Link Training or mode changes will modify the content of the 

DPCD registers 
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HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content 

Protection) status and controlling the HDCP capabilities of the connected UCD-424 device. 

Status 

The status fields indicate the HDCP status of the connected UCD-424 device. 

Active: The stream between UCD-424 and the downstream sink has been encrypted. 

Authenticated: The HDCP handshake between the UCD-424 and the sink unit has been 

completed successfully. 

Authentication in process: The HDCP handshake is in process between the UCD-424 and 

the downstream sink unit. 

Keys loaded: The HDCP keys are loaded to the UCD-424 unit. 

Configuration 

Enable encryption: Check to enable the encryption of the stream between UCD-424 and the 

downstream sink. 

Authenticate: Perform the HDCP initiation handshake between the UCD-424 and the sink 

unit. 

Keys 

Select between Production or Facsimile HDCP keys. To remove the keys, select None.  

Content level 

Selection of Type 1 content ensures that content encryption is done with HDCP version 2.2 

or higher. 

HDCP 1.3 vs. HDCP 2.3 

UCD-424 devices support by default HDCP 1.3 and HDCP 2.3. 
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FEC Tab 
Forward Error Correction (FEC) can be enabled if connected sink supports it. For debug 

purposes, error injection to main-link is possible. There is an error type for each standard 

sink DPCD error counter.  

FEC 

Clicking Enable FEC UCD-424 will verify if connected sink supports FEC and begins the 

handshake for enabling FEC. 

Clicking Disable FEC UCD-424 will start the FEC disable handshake. 

If Prefer FEC Enabled is selected and the connected sink supports FEC, UCD-424 will 

start the FEC Enable Sequence after a successful connection. 

Error Generator 

Generate errors of type: selection will set how many errors will be inserted into one FEC 

block and to which link symbols. There are five options: 

• Uncorrected block: 3 symbol errors with 3 error bits together 

• Corrected block: 2 symbol errors with 2 error bits together 

• Corrected parity: 2 parity byte errors with 2 error bits together 

• Corrected block 1 error 

• Corrected parity 1 error 

Note:  FEC must be enabled and running before errors can be added. 
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Each lane can have its individual error amount. Errors can be injected to even and odd 

decoders by using lane #0 and lane #1 counters when link is configured to one lane. 

Clicking Apply will start error injection. 

Clicking Update will read sink DPCD FEC error counter registers. 

Clicking Clear counters will clear sink DPCD FEC error counter registers. 

Note:  Link training will reset sink FEC error counters. 

Debug FEC Sequencing 

When clicking Send FEC Enable Sequence UCD-424 will start adding FEC Enable 

Sequence in its main link data. 

When clicking Send FEC Disable Sequence, UCD-424 will start adding FEC Disable 

Sequence in its main link data. 
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Sink DUT Testing Tab 
Please refer to Appendix E later in this document for description of the tests available. 

Sink DUT Testing enables the execution of HDCP 2.3 Compliance Tests for a DP Sink 

DUT. Sink DUT Testing enables testing of a DP Sink DUT. Please refer to Appendix E of 

this document to get a full definition of the Test Cases and test parameters. 

Select the tests for execution by clicking the corresponding row.  

Clicking Configure… opens a dialog for defining the test parameters for that set. Please 

refer to Test Parameters below for description. 

Parameters from Test descriptor files can be loaded with Import and stored with Export. 

Please refer to chapter Exporting Tests for TSI later in this document. 

Tests are started by clicking Run Selected. By clicking Abort the sequence is stopped. 

Test flow can be controlled with Repeats of the test sequence, Delay between individual 

tests or Stop on Failure that stops the whole sequence if one of the tests fail. 

At the completion of each test the result of the test is indicated in the matrix on the right 

hand side of the test panel. For each test the matrix lists the number of occurrences of each 

result and the number of tries performed. 

Click Save Report to generate a HTML report file for sharing the results with other parties 

for viewing without UCD Console. 

By clicking Clear All the test log and the results matrix are cleared. 
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Test Parameters 

Each test set has its dedicated set of test parameters. To open a dialog for defining the 

parameters click Configure…. 

Parameters of LL CTS Tests 

Link-Layer Tests parameter panel defines which resolutions and video modes are used for 

testing.  

They can be defined in the matrix in the dialog by selecting Use test configuration (below) 

or determined by evaluating content of DUT EDID by selecting Use sink DUT EDID. 

Parameters of HDCP CTS Tests 

HDCP CTS Tests have their own parameter dialog. 

Saving and Loading Presets 

In all parameter dialogs the selected parameters can be saved as Presets. Please click 

Presets… to save or recall a configuration.  
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Exporting Tests for TSI 

Unigraf UCD Console includes a feature rich Software Development Kit (SDK) for use in 

automated testing. The SDK is called Test Software Interface (TSI). TSI allows for an easy 

integration of Production and R&D testing routines into an automated test system 

environment. Please refer to TSI documentation found in additional Unigraf manuals for 

details. 

The tests included in UCD Console’s Source DUT Testing tab and Sink DUT Testing tab 

can be executed in TSI environment. A straightforward way is to use UCD Console’s 

Tools > TSI Integration dialog to create the necessary files for TSI environment and use 

Export function in DUT Testing tabs to include the intended tests. 

Export: Save parameters of the selected test to a file. If TSI Integration is enabled in  

Tools > Options, also the test is appended into ‘Run Test’ file in TSI workspace folder. 

Import: Recall parameters from configuration file. If TSI Integration is enabled in Tools > 

Options, parameters are imported from a file in TSI workspace folder 
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 COMPLIANCE TESTS 

Compliance test capability is a license enabled add-on to UCD Console.  

The tests are included in the GUI software, license codes enable the tests for use. Please 

refer to Appendix B Licensing for details. The list of compliance tests that UCD Console 

supports, please refer to document DP CTS Tool Options for Unigraf UCD-400.pdf. It can 

be downloaded in Unigraf Documents at https://www.unigraf.fi/documents/ If you have any 

additional questions, please contact Unigraf or your local representative. 

Compliance tests (CTS Tests) are part of tests included in Source DUT Testing tab of 

DP RX and Sink DUT Testing tab of DP TX. 

The tests cases are divided to test categories as described in Appendix E of this document. 

Each test category can be found in its dedicated sub-tab. The sub-tabs as in turn enabled by 

the licenses present in user’s PC. Please refer to chapter 3 License Manager earlier in this 

document. 

DSC Test Content 

When running DSC Compliance Tests, UCD-424 needs to have access to DSC content used 

as test patterns. The content can be created from the source bitmap files downloaded during 

installation (optional) either with Unigraf DSC Content Creator or created by the 

Compliance Test Tool on-the-fly during the compliance test. 

Options 

In Tools > Options menu you can define DSC Work folder DSC test content directory.  

You can also select to Automatically create missing content, automatically create the DSC 

compressed content used for testing the DUT. You can also Keep auto-created DSC content 

files: By default, the DSC compressed content is deleted after use. If selected, the content is 

not kept, not deleted. 

https://www.unigraf.fi/documents/
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Warning Keeping the automatically created DSC compressed content will shorten the time 

needed for running the DSC compliance tests.  

 Please note, that the space needed for storing the full library can be very large 

(appr. 200 GBytes). Please make sure that the content will be stored in a medium 

that has the required space available. 

Test Parameters 
Before running the tests, capabilities of the DUT have to be defined for the test engine. 

Each test category has its dedicated test parameter dialog. Click Configure… in Source 

DUT Testing or Sink DUT Testing tab to open the parameter dialog. 

For a detailed description of capabilities listed on the tab please refer to Chapter 3 

Compliance Test Operation of document VESA DisplayPort v1.4a Link Layer Compliance 

Test Specification. 

Note Please make sure that the capability tables are completed before running the tests. 

The result of the test might be misleading if the DUT capabilities and the table do 

not match. 

Saving Test Parameters 

Test parameters can be saved for later use in two ways: internally or externally in a file. 

In parameter dialog the parameter set can be saved as an internal Preset. 

In Source or Sink DUT Testing tab Export saves test definitions of each selected test in a 

separate file. Import loads the parameters back to UCD Console. They can be run with 

Unigraf TSI. Please refer to chapter 7.3.6 Running Tests in document TSI-X_Reference.pdf 

in UCD Console release package. 
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Running CTS Tests 
Source DUT Testing and Sink DUT Testing tabs include the tests enabled with the set of 

licenses present in UCD Console. The tests are grouped in test set tabs. In tabs the tests are 

listed by the test name and reference number as presented in applicable compliance test 

specification. UCD-424 firmware implements the test according to the test specification.  

For running a test, select it and click Run selected. For selecting multiple consecutive tests 

in the list hold down the Shift key of your keyboard while selecting the tests. For selecting 

multiple individual tests hold down the Ctrl key in your keyboard while selecting. 

Repeats defines number of test-runs and the Delay time delay between the tests. When 

repeating a sequence of tests, all selected tests are performed in each repetition. E.g. when 

you repeat tests 1, 2 and 3 two times, the sequence is: 1, 2, 3, 1, 2, 3. 

Test flow parameters like Test timeout and Test cycle delay can be defined in Test 

Parameter dialog launched by clicking Configure…. 

Selecting Stop on Failure stops execution of a series of tests in case a failure is found. 

For clearing the Status Log and the Results matrix, click Clear All. 
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Evaluating CTS Test Results 

The test procedure advancement can be monitored in the Test Log panel. It describes the 

steps of each individual test in the way defined in the corresponding VESA Compliance 

Test Specification. Please use the Status Log and Specification side by side when 

interpreting the results. 

At the completion of each test the result of the test is indicated in the matrix on the right 

hand side of the test panel. For each test the matrix lists the number of occurrences of each 

result and the number of tries performed. 
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Test Report 
Results of the test can be saved as a report in HTML format.  

Click Save Report in UCD Console. A dialog will open where information about the DUT 

and remarks about the test can be included in the report. Details of the used test equipment 

and the software and firmware version will be added automatically. 

Viewing the CTS Test Report 
The report file can be viewed with any HTML browser. The report has built-in views for 

Report Summary, Test Summary and individual Test Logs. 
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 EVENT LOG 
Event Logger (Event Log) vertical tab can be seen on the left edge of the GUI. Event Log is 

enabled with UCD Pro for DP Sink or UCD Pro for DP Source license. 

Event Log dialog is divided into two panels: the left panel lists all transactions, and the 

right panel shows the parsed transaction data for the line selected in the list on the left. 

With the Event Logger captures the following items  

• HPD status (DP TX and DP RX) 

• AUX transaction (DP TX and DP RX) 

• DP SDP messages (DP RX) 

• Changes in MSA (DP RX) 

• Changes in VB-ID (DP RX) 

• USB-C PD transaction 

Each item line includes Time stamp, Type indication, Message source, and raw message 

data. The right panel lists the content of one message. Messages belonging together with 

the selected one are shown in red color.  

 Start event logging by clicking Start Capture and stop it by clicking Stop Capture. 

 The transactions can be saved in binary *.evt Event Log files by clicking Save. Saved 

Event Log files can be recalled by clicking Open.  

 Clicking Report stores event logs as html reports to be shared and viewed with any web 

browser. The save dialog allows inclusion of detailed information about the DUT and the 

test in free-text Report information.  
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DP AUX Analyzer 
DP AUX Analyzer functionality is enabled in UCD-424 by default. 

The AUX Analyzer tabs collect AUX Channel Transactions from the Event Log in the 

Transaction list. The user can parse the content of each transaction by clicking the 

corresponding transaction line. The parsed content is in the Message Details panel on the 

right. 

Please refer to chapter Customizing the Main Window below for details on how to modify 

the content and look of the Transaction list. 

Lines 

The data is organized in lines, each numbered starting from 1 and marked with a 

timestamp. There are four kinds of lines: 

1. Information lines 

Identified by the text “INFO” in their Type column, they provide some useful 

information like the time acquisition has started and stopped or the logical state of 

the inputs, etc. 

2. Transaction lines 

Identified by the text “Native” or “I2C” in their Type column, they report an AUX 

channel data transfer, either a data Request or a data Reply. 

3. Event lines 

Identified by the text “Event” in their Type column, they signal the state change in 

one or more of the monitored inputs. 

4. Sideband Channel Messages 

The Isochronous Transport Service uses the sideband communications over 

sideband channel (AUX CH and HPD) for the management of topology/virtual 

channel connection/Main Link and performs Main Link symbol mapping. 
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5. Error lines 

A line Type reading “Error” marks the detection of an illegal AUX channel data 

packet. An irregular start condition, an irregular stop condition or transfer of a 

number of bits which is not a multiple of 8 are all conditions that cause an error line. 

6. Trace lines 

Combines the data from several lines of a HDCP related message to one entry in 

Message details panel for easier readability. 

Columns 
The data on each line is ordered in columns. Each column provides additional information 

about the data line, facilitating its viewing and interpretation: 

Line 

This column displays the line number, starting from 1, and cannot be hidden. 

Timestamp 

Each line is identified by its timestamp, marking the instant when an event or error was 

detected, or when a data transaction got started. The timestamp can be displayed as a time 

delay from the start of the acquisition (absolute) or from the previous line (relative). The 

timestamp can be displayed in milliseconds or in minutes, seconds and microseconds. 

From 

This column indicates the originator of the data line: 

• “Source” and “Sink” for an AUX channel transaction, respectively a data 

Request and a data Reply. 

• “Source Trace” and “Sink Trace” respectively for Sideband Message data 

Request and Reply. 

• “Unknown” for signal state change events. 

Type 

This column provides additional information about the type of the line: 

• “Native” marks Native AUX channel Requests and Replies. 

• “I2C” marks I2C AUX channel Requests and Replies. 

• “Sideband Request” and “Sideband Reply” to mark the Sideband Channel 

messages 

• “Event” is used for signal state change events. 

• “INFO” is used with information lines. 

• “Error” is used for illegal conditions detected on the AUX channel. 

Details 

This column contains an abbreviated description of the line content in textual form. 

Data 

The binary data exchanged during AUX channel transactions, in hexadecimal notation. 

Find 

To locate an access to a DPCD location right-click on the list and select Find… or select 

Ctrl+F from keyboard. To Find again select F3. 
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Message Details 

The Message details panel is used to provide a detailed explanation of the line currently 

selected in the Transaction list. For AUX channel transaction lines, for each of the DPCD 

memory locations affected, the panel lists: 

• All data bytes read or written. 

• All DPCD memory locations affected. 

• The name of the locations and of each of their bit fields. 

• All bit field’s numeric and binary values, together with their decoded value. 

• The Replies outcome (AUX_ACK, AUX_NACK, I2C_DEFER, etc.). 

Customizing the Main Window 

Format of the data shown in the Transaction list and the Message details panels can be 

altered in order to highlight the details of your interest. 

Selecting Data Columns 

The Transaction list can be customized by right-clicking over the list. The pop-up menu 

allows choosing which columns to display, the style of the timestamp and switch between 

absolute and relative timestamps. Filters limit the transactions shown in the list. Please see 

Filtering later in this document. 

Selecting Font and Colors 

Select Tools > Options > AUX Analyzer options tab. Click Select new font and choose 

the font and size used for displaying the Transaction list and the Message details.  



 Event Log
  

 76.  

Transaction List Color Options 

Select the colors for the font and background of various items. 

Highlighted DPCD Address Ranges 

In order to improve the readability of the Transaction list, you can mark the AUX channel 

transactions where a certain DPCD register address or address range is highlighted with a 

color of choice. 

Click Add…, select the access type, start DPCD address and end DPCD address of the 

range in Hex. Click Accept. 

Select the range you just created from the Highlighted DPCD addresses ranges list and 

click the Change test color and Change background color buttons to select the colors 

desired. 

You can create multiple simultaneous coloring rules to help you get a better view of the 

data captured. 
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Filtering  

Transactions lines shown in the transaction list can be limited by Filtering. The shown lines 

can be selected by: 

• The type of data line 

• The origin of the message 

• The DPCD address range 

Right click > Filters drop down menu lists a set of pre-programmed filters. 

Editing Filters 

From Custom Filter dialog (Tools > Options > Edit Custom Filters …) allows for 

adding and modifying filters. The pre-programmed filters are listed in the dialog. 

Their structure can be copied as bases of your custom filters. It is advisable not to 

modify the pre-programmed filters directly but make copies of them. 

In the Stored custom filter definitions panel, lists currently defined Filters. On the 

right hand side buttons, you can define new Filters, rename or delete them. Their 

appearance in the Filters pull-down menu can also be altered. 

In the Filter Rules panel lower in the dialog you can review and change the Rules in 

the selected Filter. Add… creates new rules, Edit… enables review and editing 

existing Filters and Remove deletes from the Filter definition. 
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When clicking Add… or Edit… Edit Filter Rule dialog opens. The dialog defines 

the action of the rule, events and event details. 

Click Help to show “Help” text also attached to Appendix F of this document. 

Note Please note that Filters are a very powerful tool. They can however unintentionally 

hide valuable data from you. Please be careful when applying custom filters. 

A good practice is to start from an existing filter and gradually add new rules while 

testing their performance.  

 

Note  Filtering and selecting the columns for display do not affect the actual data 

acquisition. All transactions and their full data are always captured. 
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 EDID EDITOR 
The EDID Editor main window is divided into three logical areas. The bottom part of the 

window contains the command buttons, and the log view. The top-left portion shows the 

currently edited E-EDID blocks in a tree-form, and the top-right portion shows an edit 

control for the currently selected item, possibly a list of sub-keys and their names (The list 

is not shown for all values) and the HEX-view of the block collection. 

Command Buttons 

Load: Load an EDID block collection file from disk. 

Save: Save the current block collection to a disk file. 

Show Hex: Show or Hide the HEX view. 

Show Log: Show or Hide the Log view. 

EDID Editor Features 

The EDID Editor currently supports VESA E-EDID block versions 1.3 and 1.4. As the 

standard defines, the versions 1.0, 1.1 and 1.2 are supposed to be backward compatible, and 

therefore the VESA E-EDID decoder will also show their contents. However, in these cases 

it should be noted that the error checking is not compliant with restrictions given in these 

older versions of the standard. In addition to VESA E-EDID block, the CEA-861 versions 

1, 2 and 3 EDID blocks are also fully supported as well as the VESA Block Map Extension 

blocks. 

Practically unlimited number of extension blocks may exist in a single collection. The 

number of blocks is limited by VESA Specifications and possibly by available system 

resources. Most EDID blocks contain a structure that is very similar to a tree-structure. The 

EDID Editor decodes each block into a tree-view of the block. The tree-view then contains 

all values contained within the EDID block. The contents can then be easily browsed, using 

only a few mouse clicks. The EDID Editor has a support for automatic variables, such as 

the block checksum. When the user changes a value in an EDID block, the tool will update 

the checksum accordingly. The automatic variables appear as read only values for the user. 

A log print will be made when an automatic variable is updated by the editor.  

HEX View: An optional HEX data display of all blocks in the collection. The view also 

shows the latest changes highlighted. 

LOG View: An optional LOG view, which will contain log prints generated by the editor. 

Mostly it will list values that have been automatically updated due to edits. 
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Editing Tips 

Editing an EDID block is very straightforward, but there are some special cases where the 

user must know how to accomplish certain types of tasks. 

• Enter key will apply text-edit values and combo-box selection. 

• To apply new setting to binary values (ones that show a check-box), please click the 

Set button. 

• When you see a Quick Config button appear below an editor, you can access a 

configuration menu that allows you to quickly select one of multiple pre-defined 

setup options. 

• In CEA-861 blocks, you can add and remove 18-byte descriptors and CEA data 

blocks by setting the values “18-byte Descriptors in this block” and “CEA Data block 

count”. Unfortunately re-arranging the descriptors and CEA data blocks is not 

supported yet, so you need to be careful when editing these. 

• Enter hex values with prefix “0x” or “$”, no prefix means a decimal value. 

• You can always enter HEX or DEC, even if the value is presented as HEX, and/or 

value range is given in HEX. 

• Floating point values must be given with period “.” as decimal separator, even if your 

localization setting defines decimal separator as comma (or other). 

• Remember to click Set after changing a bit-value presented as a single check-box if 

you want the new value applied. 

Note It is recommended that you back up the un-edited EDID contents to a file before 

editing and writing it to the card. 

Saving EDID Data 
When you are done with editing you can either save the EDID contents to a file in the PC 

or bring it in the HEX Editor.  

For saving the data to a file in your PC click Save. 

For bringing the data to the HEX Editor close the EDID Editor window by clicking the 

Window Close button in the top right-hand corner of the window. You will be asked if you 

would like to copy and replace the EDID data in the HEX Editor. Click Yes to replace the 

data, click No to discard the modifications.  

When you are back in the HEX Editor, the bytes that the EDID Editor changed are 

highlighted with BLUE BACKGROUND. 
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APPENDIX A. PRODUCT SPECIFICATION 

UCD-424 

Input (USB-C DP Rx) USB-C & PD 3.0 compliant DRP port with DP 1.4a Alt Mode 
Receiver capability 

Output (USB-C DP Tx) USB-C & PD 3.0 compliant DRP port with DP 1.4a Alt Mode 
Transmitter capability 

USB Pass Through USB3.2 Gen2 data pass-through between test interfaces 

Vbus Power Up to 3A@9V input and output 

Max video mode 7680 × 4320 p30 input and output 

3840 × 2160 p120 input and output 

Audio LPCM, 2 – 8 channels, 44.1 to 192 kHz 

Content Protection HDCP 2.3, HDCP 1.3 

DSC Capability DSC DSC 1.2a sink with off-line decompression 

DSC DSC 1.2a source using pre-compressed content 

Support RGB / YCbCr up to 12 bits per component 

24 slices, max with 7680 pixels 

Additional features FEC, LTTPR, DSC 

DP 1.4a LL CTS, DP DSC CTS 

HDCP 2.3 CTS 

Computer interface USB 3.0 

Operating System Windows 10, 8 and 7 macOS*,  
Linux* and Asterix* available Q2/20 

Software UCD Console GUI, TSI API with interface specific Test Sets 

Power supply AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +12 Vdc output) 

Mechanical Size 310 × 190 × 61 mm 

Weight 1.3 kg w/o power supply 

 

*) Please contact Unigraf for detailed availability 
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APPENDIX B. LICENSING 

UCD Console & TSI: USB-C DP Alt Mode Reference Sink (DP RX) 

Tab Function 

B
asic* 
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S
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D
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 1.4a LL C
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for testing S
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USB-C         

 USB-C Data Role Status & Control ● ●     

 USB-C Power Role status & Control ● ●     

 
USB-C Vbus / CC / Vconn voltage / current 
monitoring 

● ●     

Video        
 Preview, Capture, Snap preview ● ●     
 Status ● ●     

Audio        
 Monitor, Capture and graphical preview  ● ●     
 Status ● ●     

Link        
 Link Status, Link Configuration ● ●     

 Stream Status (video, audio) ● ●     

 HPD Status, HPD Assert / De-assert, HPD 
Long Pulse, HPD Short Pulse 

● ●     

 MST Feature (up to 4 streams) ● ●     

 FEC Feature ● ●     

 DSC Decoder, DSC Configuration   ■    

EDID        
 Read / Write, Save / Load ● ●     

 EDID Editor ●      

DPCD        
 Read/Write, Save/Load ● ●     
 DPCD Decoder ●      

HDCP        

 HDCP 1.3 and HDCP 2.3 Support ● ●     
 Authentication status, Encryption status ● ●     

Event Log        

 Event Log ● ●     

 DP AUX Analyzer ●      

Source DUT Testing         

 Execute TSI Tests ● ●     

 Execute DP LL, Audio and FEC CTS    ■   

 Execute DSC CTS   ■    

 HDCP 2.3 CTS for testing DP Source DUT     ■ ■ 

 HDCP 2.3 CTS for testing DP Repeater DUT      ■ 

*) UCD-424 is delivered by default with UCD Console Pro for Type-C DP Sink, UCD Console Pro for 

Type-C DP Source and HDCP 2.3 support enabling license keys 

**) UCD-424 is delivered by default with TSI SDK Advanced with HDCP 2.3 support key 
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UCD Console & TSI: USB-C DP Alt Mode Reference Source (DP TX) 

Tab Function 

B
asic* 

T
S

I B
asic** 

D
S

C
 E

ncoder 

LT
T

P
R

 

D
P

 1.4a LL C
T

S
 

for testing S
ink D

U
T

 

H
D

C
P

 2.3 C
T

S
 

for testing S
ink D

U
T

 

H
D

C
P

 2.3 C
T

S
 

for testing R
epeater D

U
T

 

USB-C          

 USB-C Data Role Status & Control ● ●      

 USB-C Power Role status & Control ● ●      

 
USB-C Vbus / CC / Vconn voltage /  
current monitoring 

● ●      

Pattern Generator         

 Fixed and custom Video Timings  ● ●      

 Fixed and custom Video Patterns ● ●      

Audio Generator         

 Play audio files ● ●      

Link          
 Link Status  ● ●      
 HPD Status: (Asserted / De-asserted) ● ●      

 Link Configuration: (Lane count, Link Rate, 
Framing mode, Clock mode) 

● ●     
 

 MST Feature (up to 4 streams) ● ●      

 FEC Feature ● ●      

 DSC Encoder   ■     

 LTTPR Feature    ■    

EDID          

 Read / Write, Save / Load ● ●      

 EDID Editor ●       

DPCD          

 Read / Write, Save / Load ● ●      

 DPCD Decoder ●       

HDCP          

 HDCP 1.3 Support ● ●      

 Control: (Enable / Disable, authenticate only,  
Encryption Enable / Disable) 

● ●     
 

 Status: (Authentication status,  
Encryption status) 

● ●     
 

 HDCP 2.3 Support ● ●      

Event Log         

 Event Log ● ●      

 DP AUX Analyzer ●       

Sink DUT Testing          

 Execute TSI Tests ● ●      

 Execute DP LL, Audio and FEC CTS      ■   

 Execute DSC CTS   ■     

 HDCP 2.3 CTS for testing DP Sink DUT      ■ ■ 

 HDCP 2.3 CTS for testing DP Repeater DUT       ■ 

*) UCD-424 is delivered by default with UCD Console Pro for Type-C DP Sink, UCD Console Pro for 

Type-C DP Source and HDCP 2.3 support enabling license keys 

**) UCD-424 is delivered by default with TSI SDK Advanced with HDCP 2.3 support key 
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APPENDIX C: PREDEFINED TIMINGS 
DisplayPort Sink and Source Capability (RGB) (4 lanes capability) 

Description 
H 

active 
V 

active 
H 

total 
V 

total 
Frame 

rate 

RGB 4:4:4 

6 8  10  12  16  

VESA 640 x 480 @ 60Hz 640 480 800 525 60 ● ● ● ● ● 

VESA 800 x 600 @ 60Hz 800 600 1056 628 60 ● ● ● ● ● 

VESA 848 x 480 @ 60Hz 848 480 1088 517 60 ● ● ● ● ● 

VESA 1024 x 768 @ 60Hz 1024 768 1344 806 60 ● ● ● ● ● 

CTA 1280 x 720 @ 60Hz 1280 720 1650 750 60 ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 1280 768 1664 798 60 ● ● ● ● ● 

VESA 1280 x 960 @ 60Hz 1280 960 1800 1000 60 ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz [RB1] 1280 800 1440 823 60 ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz 1280 800 1680 831 60 ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 1280 768 1440 790 60 ● ● ● ● ● 

VESA 1280 x 1024 @ 60Hz 1280 1024 1688 1066 60 ● ● ● ● ● 

VESA 1360 x 768 @ 60Hz 1360 768 1792 795 60 ● ● ● ● ● 

VESA 1400 x 1050 @ 60Hz 1400 1050 1560 1080 60 ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz [RB1] 1600 1200 1760 1235 60 ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz 1600 1200 2160 1250 60 ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz 1680 1050 2240 1089 60 ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz [RB1] 1680 1050 1840 1080 60 ● ● ● ● ● 

VESA 1792 x 1344 @ 60Hz 1792 1344 2448 1394 60 ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB1] 1920 1080 2080 1096 30 ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB2] 1920 1080 2000 1096 30 ● ● ● ● ● 

CTA 1920 x 1080 @ 30Hz 1920 1080 2200 1125 30 ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB1] 1920 1080 2080 1111 60 ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB2] 1920 1080 2000 1111 60 ● ● ● ● ● 

CTA 1920 x 1080 @ 60Hz 1920 1080 2200 1125 60 ● ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB1] 1920 1080 2080 1144 120 ● ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB2] 1920 1080 2000 1144 120 ● ● ● ● ● 

CTA 1920 x 1080 @ 120Hz 1920 1080 2200 1125 120 ● ● ● ● ● 

VESA 1920 x 1440 @ 60Hz 1920 1440 2600 1500 60 ● ● ● ● ● 

VESA 2048 x 1536 @ 60Hz 2048 1536 2208 1580 60 ● ● ● ● ● 

VESA 2560 x 1440 @ 60Hz 2560 1440 2720 1481 60 ● ● ● ● ● 

VESA 2560 x 1080 @ 60Hz 2560 1080 3424 1120 60 ● ● ● ● ● 

VESA 2560 x 1080 @ 60Hz [RB1] 2560 1080 2720 1111 60 ● ● ● ● ● 

VESA 2560 x 1600 @ 60Hz 2560 1600 3504 1658 60 ● ● ● ● ● 

VESA 2560 x 1600 @ 60Hz [RB1] 2560 1600 2720 1646 60 ● ● ● ● ● 

Other 2880 x 1440 @ 60Hz 2880 1440 2976 1456 60 ● ● ● ● ● 

VESA 4096 x 2160 @ 60Hz 4096 2160 4176 2222 60 ● ● ● ■ ▲ 

VESA 3840 x 2160 @ 30Hz [RB1] 3840 2160 4000 2191 30 ● ● ● ● ● 

VESA 3840 x 2160 @ 30Hz [RB2] 3840 2160 3920 2191 30 ● ● ● ● ● 

CTA 3840 x 2160 @ 30Hz 3840 2160 4400 2250 30 ● ● ● ● ● 

CTA 3840 x 2160 @ 50Hz 3840 2160 5280 2250 50 ● ● ■ ■ ▲ 

CTA 4096 x 2160 @ 50Hz 4096 2160 5280 2250 50 ● ● ■ ■ ▲ 

VESA 3840 x 2160 @ 60Hz [RB1] 3840 2160 4000 2222 60 ● ● ● ■ ■ 

VESA 3840 x 2160 @ 60Hz [RB2] 3840 2160 3920 2222 60 ● ● ● ■ ■ 

CTA 3840 x 2160 @ 60Hz 3840 2160 4400 2250 60 ● ● ■ ■ ▲ 

CTA 4096 x 2160 @ 60Hz 4096 2160 4400 2250 60 ● ● ■ ■ ▲ 

 

● Supported ■ Supported with HBR3 ▲ Supported with DSC 
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DisplayPort Sink and Source Capability (RGB) (4 lanes capability) contd. 

Description 
H 

active 
V 

active 
H 

total 
V 

total 
Frame 

rate 

RGB 4:4:4 

6 8  10  12  16  

VESA 3840 x 2160 @ 120Hz [RB1] 3840 2160 4000 2287 120 ■ ▲ ▲ ▲ ▲ 

VESA 3840 x 2160 @ 120Hz [RB2] 3840 2160 3920 2287 120 ■ ▲ ▲ ▲ ▲ 

CTA 3840 x 2160 @ 120Hz 3840 2160 4400 2250 120 ■ ▲ ▲ ▲ ▲ 

VESA 5120 x 2160 @ 30Hz [RB1] 5120 2160 5280 2191 30 ● ● ● ● ● 

VESA 5120 x 2160 @ 30Hz [RB2] 5120 2160 5200 2191 30 ● ● ● ● ● 

CTA 5120 x 2160 @ 30Hz 5120 2160 6000 2200 30 ● ● ● ● ■ 

VESA 5120 x 2160 @ 60Hz [RB1] 5120 2160 5280 2222 60 ● ● ■ ■ ▲ 

VESA 5120 x 2160 @ 60Hz [RB2] 5120 2160 5200 2222 60 ● ● ■ ■ ▲ 

CTA 5120 x 2160 @ 60Hz 5120 2160 5500 2250 60 ● ■ ■ ▲ ▲ 

VESA 5120 x 2160 @ 120Hz [RB1] 5120 2160 5280 2287 120 ▲ ▲ ▲ ▲ ▲ 

VESA 5120 x 2160 @ 120Hz [RB2] 5120 2160 5200 2287 120 ■ ▲ ▲ ▲ ▲ 

CTA 5120 x 2160 @ 120Hz 5120 2160 5500 2250 120 ▲ ▲ ▲ ▲ ▲ 

Other 5120 x 2880 @ 60Hz 5120 2880 5280 2962 60 ● ■ ▲ ▲ ▲ 

VESA 7680 x 4320 @ 30Hz [RB1] 7680 4320 7840 4381 30 ■ ■ ▲ ▲ ▲ 

VESA 7680 x 4320 @ 30Hz [RB2] 7680 4320 7760 4381 30 ■ ■ ▲ ▲ ▲ 

CTA 7680 x 4320 @ 30Hz 7680 4320 9000 4400 30 ■ ▲ ▲ ▲ ▲ 

VESA 7680 x 4320 @ 60Hz [RB1] 7680 4320 7840 4443 60 ▲ ▲ ▲ ▲  

VESA 7680 x 4320 @ 60Hz [RB2] 7680 4320 7760 4443 60 ▲ ▲ ▲ ▲  

CTA 7680 x 4320 @ 60Hz 7680 4320 9000 4400 60 ▲ ▲ ▲   

VESA 7680 x 4320 @ 100Hz [RB1] 7680 4320 7840 4529 100 ▲     

VESA 7680 x 4320 @ 100Hz [RB2] 7680 4320 7760 4529 100 ▲     

CTA 7680 x 4320 @ 100Hz 7680 4320 10560 4500 100      

 

● Supported ■ Supported with HBR3 ▲ Supported with DSC 
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DisplayPort Sink and Source Capability (YCbCr) (4 lanes capability) 

Description 
H 

active 
V 

active 
H 

total 
V 

total 
Frame 

rate 

YCbCr 4:2:2 (bpc) YCbCr 4:2:0 (bpc) 

8  10   12   16  8   10   12   16   

VESA 640 x 480 @ 60Hz 640 480 800 525 60 ● ● ● ● ● ● ● ● 

VESA 800 x 600 @ 60Hz 800 600 1056 628 60 ● ● ● ● ● ● ● ● 

VESA 848 x 480 @ 60Hz 848 480 1088 517 60 ● ● ● ● ● ● ● ● 

VESA 1024 x 768 @ 60Hz 1024 768 1344 806 60 ● ● ● ● ● ● ● ● 

CTA 1280 x 720 @ 60Hz 1280 720 1650 750 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 1280 768 1664 798 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 960 @ 60Hz 1280 960 1800 1000 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz [RB1] 1280 800 1440 823 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz 1280 800 1680 831 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 1280 768 1440 790 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 1024 @ 60Hz 1280 1024 1688 1066 60 ● ● ● ● ● ● ● ● 

VESA 1360 x 768 @ 60Hz 1360 768 1792 795 60 ● ● ● ● ● ● ● ● 

VESA 1400 x 1050 @ 60Hz 1400 1050 1560 1080 60 ● ● ● ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz [RB1] 1600 1200 1760 1235 60 ● ● ● ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz 1600 1200 2160 1250 60 ● ● ● ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz 1680 1050 2240 1089 60 ● ● ● ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz [RB1] 1680 1050 1840 1080 60 ● ● ● ● ● ● ● ● 

VESA 1792 x 1344 @ 60Hz 1792 1344 2448 1394 60 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB1] 1920 1080 2080 1096 30 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB2] 1920 1080 2000 1096 30 ● ● ● ● ● ● ● ● 

CTA 1920 x 1080 @ 30Hz 1920 1080 2200 1125 30 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB1] 1920 1080 2080 1111 60 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB2] 1920 1080 2000 1111 60 ● ● ● ● ● ● ● ● 

CTA 1920 x 1080 @ 60Hz 1920 1080 2200 1125 60 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB1] 1920 1080 2080 1144 120 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB2] 1920 1080 2000 1144 120 ● ● ● ● ● ● ● ● 

CTA 1920 x 1080 @ 120Hz 1920 1080 2200 1125 120 ● ● ● ● ● ● ● ● 

VESA 1920 x 1440 @ 60Hz 1920 1440 2600 1500 60 ● ● ● ● ● ● ● ● 

VESA 2048 x 1536 @ 60Hz 2048 1536 2208 1580 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1440 @ 60Hz 2560 1440 2720 1481 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1080 @ 60Hz 2560 1080 3424 1120 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1080 @ 60Hz [RB1] 2560 1080 2720 1111 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1600 @ 60Hz 2560 1600 3504 1658 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1600 @ 60Hz [RB1] 2560 1600 2720 1646 60 ● ● ● ● ● ● ● ● 

Other 2880 x 1440 @ 60Hz 2880 1440 2976 1456 60 ● ● ● ● ● ● ● ● 

VESA 4096 x 2160 @ 60Hz 4096 2160 4176 2222 60 ● ● ● ■ ● ● ● ● 

VESA 3840 x 2160 @ 30Hz [RB1] 3840 2160 4000 2191 30 ● ● ● ● ● ● ● ● 

VESA 3840 x 2160 @ 30Hz [RB2] 3840 2160 3920 2191 30 ● ● ● ● ● ● ● ● 

CTA 3840 x 2160 @ 30Hz 3840 2160 4400 2250 30 ● ● ● ● ● ● ● ● 

CTA 3840 x 2160 @ 50Hz 3840 2160 5280 2250 50 ● ● ● ■ ● ● ● ● 

CTA 4096 x 2160 @ 50Hz 4096 2160 5280 2250 50 ● ● ● ■ ● ● ● ● 

VESA 3840 x 2160 @ 60Hz [RB1] 3840 2160 4000 2222 60 ● ● ● ● ● ● ● ● 

VESA 3840 x 2160 @ 60Hz [RB2] 3840 2160 3920 2222 60 ● ● ● ● ● ● ● ● 

CTA 3840 x 2160 @ 60Hz 3840 2160 4400 2250 60 ● ● ● ■ ● ● ● ● 

CTA 4096 x 2160 @ 60Hz 4096 2160 4400 2250 60 ● ● ● ■ ● ● ● ● 

 

● Supported ■ Supported with HBR3 ▲ Supported with DSC 
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DisplayPort Sink and Source Capability (YCbCr) (4 lanes capability) contd. 

Description 
H 

active 
V 

active 
H 

total 
V 

total 
Frame 

rate 

YCbCr 4:2:2 (bpc) YCbCr 4:2:0 (bpc) 

8  10   12   16  8   10   12   16   

VESA 3840 x 2160 @ 120Hz [RB1] 3840 2160 4000 2287 120 ■ ■ ▲ ▲ ● ● ■ ▲ 

VESA 3840 x 2160 @ 120Hz [RB2] 3840 2160 3920 2287 120 ■ ■ ▲ ▲ ● ● ■ ▲ 

CTA 3840 x 2160 @ 120Hz 3840 2160 4400 2250 120 ■ ■ ▲ ▲ ● ■ ■ ▲ 

VESA 5120 x 2160 @ 30Hz [RB1] 5120 2160 5280 2191 30 ● ● ● ● ● ● ● ● 

VESA 5120 x 2160 @ 30Hz [RB2] 5120 2160 5200 2191 30 ● ● ● ● ● ● ● ● 

CTA 5120 x 2160 @ 30Hz 5120 2160 6000 2200 30 ● ● ● ● ● ● ● ● 

VESA 5120 x 2160 @ 60Hz [RB1] 5120 2160 5280 2222 60 ● ● ● ■ ● ● ● ● 

VESA 5120 x 2160 @ 60Hz [RB2] 5120 2160 5200 2222 60 ● ● ● ■ ● ● ● ● 

CTA 5120 x 2160 @ 60Hz 5120 2160 5500 2250 60 ● ● ■ ■ ● ● ● ■ 

VESA 5120 x 2160 @ 120Hz [RB1] 5120 2160 5280 2287 120 ■ ▲ ▲ ▲ ■ ■ ▲ ▲ 

VESA 5120 x 2160 @ 120Hz [RB2] 5120 2160 5200 2287 120 ■ ▲ ▲ ▲ ● ■ ■ ▲ 

CTA 5120 x 2160 @ 120Hz 5120 2160 5500 2250 120 ■ ▲ ▲ ▲ ■ ■ ▲ ▲ 

Other 5120 x 2880 @ 60Hz 5120 2880 5280 2962 60 ● ■ ■ ▲ ● ● ● ■ 

VESA 7680 x 4320 @ 30Hz [RB1] 7680 4320 7840 4381 30 ● ■ ■ ▲ ● ● ■ ■ 

VESA 7680 x 4320 @ 30Hz [RB2] 7680 4320 7760 4381 30 ● ■ ■ ▲ ● ● ■ ■ 

CTA 7680 x 4320 @ 30Hz 7680 4320 9000 4400 30 ■ ■ ▲ ▲ ● ■ ■ ▲ 

VESA 7680 x 4320 @ 60Hz [RB1] 7680 4320 7840 4443 60 ▲ ▲ ▲ ▲ ■ ▲ ▲ ▲ 

VESA 7680 x 4320 @ 60Hz [RB2] 7680 4320 7760 4443 60 ▲ ▲ ▲ ▲ ■ ▲ ▲ ▲ 

CTA 7680 x 4320 @ 60Hz 7680 4320 9000 4400 60 ▲ ▲ ▲  ▲ ▲ ▲ ▲ 

VESA 7680 x 4320 @ 100Hz [RB1] 7680 4320 7840 4529 100 ▲ ▲     ▲ ▲ ▲   

VESA 7680 x 4320 @ 100Hz [RB2] 7680 4320 7760 4529 100 ▲ ▲     ▲ ▲ ▲   

CTA 7680 x 4320 @ 100Hz 7680 4320 10560 4500 100        ▲ ▲     

 

● Supported ■ Supported with HBR3 ▲ Supported with DSC 
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DisplayPort Sink and Source Capability (RGB) (2 lanes capability) 

Description 
H 

active 
V 

active 
H 

total 
V 

total 
Frame 

rate 

RGB 4:4:4 

6 8  10  12  16  

VESA 640 x 480 @ 60Hz 640 480 800 525 60 ● ● ● ● ● 

VESA 800 x 600 @ 60Hz 800 600 1056 628 60 ● ● ● ● ● 

VESA 848 x 480 @ 60Hz 848 480 1088 517 60 ● ● ● ● ● 

VESA 1024 x 768 @ 60Hz 1024 768 1344 806 60 ● ● ● ● ● 

CTA 1280 x 720 @ 60Hz 1280 720 1650 750 60 ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 1280 768 1664 798 60 ● ● ● ● ● 

VESA 1280 x 960 @ 60Hz 1280 960 1800 1000 60 ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz [RB1] 1280 800 1440 823 60 ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz 1280 800 1680 831 60 ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 1280 768 1440 790 60 ● ● ● ● ● 

VESA 1280 x 1024 @ 60Hz 1280 1024 1688 1066 60 ● ● ● ● ● 

VESA 1360 x 768 @ 60Hz 1360 768 1792 795 60 ● ● ● ● ● 

VESA 1400 x 1050 @ 60Hz 1400 1050 1560 1080 60 ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz [RB1] 1600 1200 1760 1235 60 ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz 1600 1200 2160 1250 60 ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz 1680 1050 2240 1089 60 ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz [RB1] 1680 1050 1840 1080 60 ● ● ● ● ● 

VESA 1792 x 1344 @ 60Hz 1792 1344 2448 1394 60 ● ● ● ● ■ 

VESA 1920 x 1080 @ 30Hz [RB1] 1920 1080 2080 1096 30 ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB2] 1920 1080 2000 1096 30 ● ● ● ● ● 

CTA 1920 x 1080 @ 30Hz 1920 1080 2200 1125 30 ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB1] 1920 1080 2080 1111 60 ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB2] 1920 1080 2000 1111 60 ● ● ● ● ● 

CTA 1920 x 1080 @ 60Hz 1920 1080 2200 1125 60 ● ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB1] 1920 1080 2080 1144 120 ● ● ● ■ ▲ 

VESA 1920 x 1080 @ 120Hz [RB2] 1920 1080 2000 1144 120 ● ● ● ■ ▲ 

CTA 1920 x 1080 @ 120Hz 1920 1080 2200 1125 120 ● ● ■ ■ ▲ 

VESA 1920 x 1440 @ 60Hz 1920 1440 2600 1500 60 ● ● ● ● ■ 

VESA 2048 x 1536 @ 60Hz 2048 1536 2208 1580 60 ● ● ● ● ■ 

VESA 2560 x 1440 @ 60Hz 2560 1440 2720 1481 60 ● ● ● ■ ■ 

VESA 2560 x 1080 @ 60Hz 2560 1080 3424 1120 60 ● ● ● ● ■ 

VESA 2560 x 1080 @ 60Hz [RB1] 2560 1080 2720 1111 60 ● ● ● ● ■ 

VESA 2560 x 1600 @ 60Hz 2560 1600 3504 1658 60 ● ● ■ ■ ▲ 

VESA 2560 x 1600 @ 60Hz [RB1] 2560 1600 2720 1646 60 ● ● ● ■ ■ 

Other 2880 x 1440 @ 60Hz 2880 1440 2976 1456 60 ● ● ● ■ ■ 

VESA 4096 x 2160 @ 60Hz 4096 2160 4176 2222 60 ■ ▲ ▲ ▲ ▲ 

VESA 3840 x 2160 @ 30Hz [RB1] 3840 2160 4000 2191 30 ● ● ● ■ ■ 

VESA 3840 x 2160 @ 30Hz [RB2] 3840 2160 3920 2191 30 ● ● ● ■ ■ 

CTA 3840 x 2160 @ 30Hz 3840 2160 4400 2250 30 ● ● ■ ■ ▲ 

CTA 3840 x 2160 @ 50Hz 3840 2160 5280 2250 50 ■ ▲ ▲ ▲ ▲ 

CTA 4096 x 2160 @ 50Hz 4096 2160 5280 2250 50 ■ ▲ ▲ ▲ ▲ 

VESA 3840 x 2160 @ 60Hz [RB1] 3840 2160 4000 2222 60 ■ ■ ▲ ▲ ▲ 

VESA 3840 x 2160 @ 60Hz [RB2] 3840 2160 3920 2222 60 ■ ■ ▲ ▲ ▲ 

CTA 3840 x 2160 @ 60Hz 3840 2160 4400 2250 60 ■ ▲ ▲ ▲ ▲ 

CTA 4096 x 2160 @ 60Hz 4096 2160 4400 2250 60 ■ ▲ ▲ ▲ ▲ 

 

● Supported ■ Supported with HBR3 ▲ Supported with DSC 
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DisplayPort Sink and Source Capability (RGB) (2 lanes capability) contd. 

Description 
H 

active 
V 

active 
H 

total 
V 

total 
Frame 

rate 

RGB 4:4:4 

6 8  10  12  16  

VESA 3840 x 2160 @ 120Hz [RB1] 3840 2160 4000 2287 120 ▲ ▲ ▲   

VESA 3840 x 2160 @ 120Hz [RB2] 3840 2160 3920 2287 120 ▲ ▲ ▲   

CTA 3840 x 2160 @ 120Hz 3840 2160 4400 2250 120 ▲ ▲ ▲   

VESA 5120 x 2160 @ 30Hz [RB1] 5120 2160 5280 2191 30 ● ● ■ ■ ▲ 

VESA 5120 x 2160 @ 30Hz [RB2] 5120 2160 5200 2191 30 ● ● ■ ■ ▲ 

CTA 5120 x 2160 @ 30Hz 5120 2160 6000 2200 30 ● ■ ■ ▲ ▲ 

VESA 5120 x 2160 @ 60Hz [RB1] 5120 2160 5280 2222 60 ■ ▲ ▲ ▲ ▲ 

VESA 5120 x 2160 @ 60Hz [RB2] 5120 2160 5200 2222 60 ■ ▲ ▲ ▲ ▲ 

CTA 5120 x 2160 @ 60Hz 5120 2160 5500 2250 60 ▲ ▲ ▲ ▲ ▲ 

VESA 5120 x 2160 @ 120Hz [RB1] 5120 2160 5280 2287 120 ▲ ▲    

VESA 5120 x 2160 @ 120Hz [RB2] 5120 2160 5200 2287 120 ▲ ▲    

CTA 5120 x 2160 @ 120Hz 5120 2160 5500 2250 120 ▲ ▲    

Other 5120 x 2880 @ 60Hz 5120 2880 5280 2962 60 ▲ ▲ ▲ ▲  

VESA 7680 x 4320 @ 30Hz [RB1] 7680 4320 7840 4381 30 ▲ ▲ ▲ ▲  

VESA 7680 x 4320 @ 30Hz [RB2] 7680 4320 7760 4381 30 ▲ ▲ ▲ ▲  

CTA 7680 x 4320 @ 30Hz 7680 4320 9000 4400 30 ▲ ▲ ▲   

VESA 7680 x 4320 @ 60Hz [RB1] 7680 4320 7840 4443 60 ▲     

VESA 7680 x 4320 @ 60Hz [RB2] 7680 4320 7760 4443 60 ▲     

CTA 7680 x 4320 @ 60Hz 7680 4320 9000 4400 60      

VESA 7680 x 4320 @ 100Hz [RB1] 7680 4320 7840 4529 100      

VESA 7680 x 4320 @ 100Hz [RB2] 7680 4320 7760 4529 100      

CTA 7680 x 4320 @ 100Hz 7680 4320 10560 4500 100      

 

● Supported ■ Supported with HBR3 ▲ Supported with DSC 
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DisplayPort Sink and Source Capability (YCbCr) (2 lanes capability) 

Description 
H 

active 
V 

active 
H 

total 
V 

total 
Frame 

rate 

YCbCr 4:2:2 (bpc) YCbCr 4:2:0 (bpc) 

8  10   12   16  8   10   12   16   

VESA 640 x 480 @ 60Hz 640 480 800 525 60 ● ● ● ● ● ● ● ● 

VESA 800 x 600 @ 60Hz 800 600 1056 628 60 ● ● ● ● ● ● ● ● 

VESA 848 x 480 @ 60Hz 848 480 1088 517 60 ● ● ● ● ● ● ● ● 

VESA 1024 x 768 @ 60Hz 1024 768 1344 806 60 ● ● ● ● ● ● ● ● 

CTA 1280 x 720 @ 60Hz 1280 720 1650 750 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 1280 768 1664 798 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 960 @ 60Hz 1280 960 1800 1000 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz [RB1] 1280 800 1440 823 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 800 @ 60Hz 1280 800 1680 831 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 768 @ 60Hz 1280 768 1440 790 60 ● ● ● ● ● ● ● ● 

VESA 1280 x 1024 @ 60Hz 1280 1024 1688 1066 60 ● ● ● ● ● ● ● ● 

VESA 1360 x 768 @ 60Hz 1360 768 1792 795 60 ● ● ● ● ● ● ● ● 

VESA 1400 x 1050 @ 60Hz 1400 1050 1560 1080 60 ● ● ● ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz [RB1] 1600 1200 1760 1235 60 ● ● ● ● ● ● ● ● 

VESA 1600 x 1200 @ 60Hz 1600 1200 2160 1250 60 ● ● ● ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz 1680 1050 2240 1089 60 ● ● ● ● ● ● ● ● 

VESA 1680 x 1050 @ 60Hz [RB1] 1680 1050 1840 1080 60 ● ● ● ● ● ● ● ● 

VESA 1792 x 1344 @ 60Hz 1792 1344 2448 1394 60 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB1] 1920 1080 2080 1096 30 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 30Hz [RB2] 1920 1080 2000 1096 30 ● ● ● ● ● ● ● ● 

CTA 1920 x 1080 @ 30Hz 1920 1080 2200 1125 30 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB1] 1920 1080 2080 1111 60 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 60Hz [RB2] 1920 1080 2000 1111 60 ● ● ● ● ● ● ● ● 

CTA 1920 x 1080 @ 60Hz 1920 1080 2200 1125 60 ● ● ● ● ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB1] 1920 1080 2080 1144 120 ● ● ● ■ ● ● ● ● 

VESA 1920 x 1080 @ 120Hz [RB2] 1920 1080 2000 1144 120 ● ● ● ■ ● ● ● ● 

CTA 1920 x 1080 @ 120Hz 1920 1080 2200 1125 120 ● ● ● ● ● ● ● ● 

VESA 1920 x 1440 @ 60Hz 1920 1440 2600 1500 60 ● ● ● ● ● ● ● ● 

VESA 2048 x 1536 @ 60Hz 2048 1536 2208 1580 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1440 @ 60Hz 2560 1440 2720 1481 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1080 @ 60Hz 2560 1080 3424 1120 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1080 @ 60Hz [RB1] 2560 1080 2720 1111 60 ● ● ● ● ● ● ● ● 

VESA 2560 x 1600 @ 60Hz 2560 1600 3504 1658 60 ● ● ● ■ ● ● ● ● 

VESA 2560 x 1600 @ 60Hz [RB1] 2560 1600 2720 1646 60 ● ● ● ● ● ● ● ● 

Other 2880 x 1440 @ 60Hz 2880 1440 2976 1456 60 ● ● ● ● ● ● ● ● 

VESA 4096 x 2160 @ 60Hz 4096 2160 4176 2222 60 ■ ■ ▲ ▲ ● ● ■ ▲ 

VESA 3840 x 2160 @ 30Hz [RB1] 3840 2160 4000 2191 30 ● ● ● ● ● ● ● ● 

VESA 3840 x 2160 @ 30Hz [RB2] 3840 2160 3920 2191 30 ● ● ● ● ● ● ● ● 

CTA 3840 x 2160 @ 30Hz 3840 2160 4400 2250 30 ● ● ● ■ ● ● ● ● 

CTA 3840 x 2160 @ 50Hz 3840 2160 5280 2250 50 ■ ■ ▲ ▲ ● ■ ■ ▲ 

CTA 4096 x 2160 @ 50Hz 4096 2160 5280 2250 50 ■ ■ ▲ ▲ ● ■ ■ ▲ 

VESA 3840 x 2160 @ 60Hz [RB1] 3840 2160 4000 2222 60 ● ■ ■ ▲ ● ● ■ ■ 

VESA 3840 x 2160 @ 60Hz [RB2] 3840 2160 3920 2222 60 ● ■ ■ ▲ ● ● ■ ■ 

CTA 3840 x 2160 @ 60Hz 3840 2160 4400 2250 60 ■ ■ ▲ ▲ ● ■ ■ ▲ 

CTA 4096 x 2160 @ 60Hz 4096 2160 4400 2250 60 ■ ■ ▲ ▲ ● ■ ■ ▲ 

 

● Supported ■ Supported with HBR3 ▲ Supported with DSC 
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DisplayPort Sink and Source Capability (YCbCr) (2 lanes capability) contd. 

Description 
H 

active 
V 

active 
H 

total 
V 

total 
Frame 

rate 

YCbCr 4:2:2 (bpc) YCbCr 4:2:0 (bpc) 

8  10   12   16  8   10   12   16   

VESA 3840 x 2160 @ 120Hz [RB1] 3840 2160 4000 2287 120 ▲ ▲ ▲ ▲ ▲ ▲ ▲ ▲ 

VESA 3840 x 2160 @ 120Hz [RB2] 3840 2160 3920 2287 120 ▲ ▲ ▲ ▲ ▲ ▲ ▲ ▲ 

CTA 3840 x 2160 @ 120Hz 3840 2160 4400 2250 120 ▲ ▲ ▲  ▲ ▲ ▲ ▲ 

VESA 5120 x 2160 @ 30Hz [RB1] 5120 2160 5280 2191 30 ● ● ● ■ ● ● ● ● 

VESA 5120 x 2160 @ 30Hz [RB2] 5120 2160 5200 2191 30 ● ● ● ■ ● ● ● ● 

CTA 5120 x 2160 @ 30Hz 5120 2160 6000 2200 30 ● ● ■ ■ ● ● ● ■ 

VESA 5120 x 2160 @ 60Hz [RB1] 5120 2160 5280 2222 60 ■ ▲ ▲ ▲ ● ■ ■ ▲ 

VESA 5120 x 2160 @ 60Hz [RB2] 5120 2160 5200 2222 60 ■ ▲ ▲ ▲ ● ■ ■ ▲ 

CTA 5120 x 2160 @ 60Hz 5120 2160 5500 2250 60 ■ ▲ ▲ ▲ ■ ■ ▲ ▲ 

VESA 5120 x 2160 @ 120Hz [RB1] 5120 2160 5280 2287 120 ▲ ▲ ▲  ▲ ▲ ▲ ▲ 

VESA 5120 x 2160 @ 120Hz [RB2] 5120 2160 5200 2287 120 ▲ ▲ ▲  ▲ ▲ ▲ ▲ 

CTA 5120 x 2160 @ 120Hz 5120 2160 5500 2250 120 ▲ ▲ ▲  ▲ ▲ ▲ ▲ 

Other 5120 x 2880 @ 60Hz 5120 2880 5280 2962 60 ▲ ▲ ▲ ▲ ■ ▲ ▲ ▲ 

VESA 7680 x 4320 @ 30Hz [RB1] 7680 4320 7840 4381 30 ▲ ▲ ▲ ▲ ■ ▲ ▲ ▲ 

VESA 7680 x 4320 @ 30Hz [RB2] 7680 4320 7760 4381 30 ▲ ▲ ▲ ▲ ■ ▲ ▲ ▲ 

CTA 7680 x 4320 @ 30Hz 7680 4320 9000 4400 30 ▲ ▲ ▲  ▲ ▲ ▲ ▲ 

VESA 7680 x 4320 @ 60Hz [RB1] 7680 4320 7840 4443 60 ▲    ▲ ▲ ▲  

VESA 7680 x 4320 @ 60Hz [RB2] 7680 4320 7760 4443 60 ▲    ▲ ▲ ▲  

CTA 7680 x 4320 @ 60Hz 7680 4320 9000 4400 60     ▲ ▲   

VESA 7680 x 4320 @ 100Hz [RB1] 7680 4320 7840 4529 100         

VESA 7680 x 4320 @ 100Hz [RB2] 7680 4320 7760 4529 100         

CTA 7680 x 4320 @ 100Hz 7680 4320 10560 4500 100         

 

● Supported ■ Supported with HBR3 ▲ Supported with DSC 
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APPENDIX D: PREDEFINED PATTERNS 

Selection Pattern Description 

Disabled N/A The links are activated but no video data transferred 

Color Bar 

 

100% intensity color bars of all primaries and mixed 
combinations. 

Chessboard 

 

8 by 8 chessboard with black (0%) and 100% intensity white 

Solid Black 

 

0% luminance 

Solid White 

 

100% white 

Solid Red 

 

100% red 

Solid Green 

 

100% green 

Solid Blue 

 

100% blue 

White Vertical Stripes 

 

Vertical stripes of black (0%) and white (100%).  

Parameters set the widths of the black and white stripes in 
pixels respectively. Default black / white = 20 / 20 pixels. 
Parameter range 0 to 5000. 

Gradient Vertical Stripes 

 

16 pixels high horizontal red green, blue and white stripes. 

Intensity is increased from 0 to 100% with steps defined by 
the given parameter (n). (step = n*color_depth/256). “n” 
range 0 to 5000 (default 120). 

Color Ramp 

 

Color Ramp test pattern defined by VESA DisplayPort Link 
Layer Compliance Test Specification. 

Color Square 

 

Color Square test pattern defined by VESA DisplayPort Link 
Layer Compliance Test Specification. 

Color mode can be selected between RGB, YCbCr 4:4:4, 
4:2:2, 4:2:0 (ITU Rec 601 / 709) 

White Square 

 

100% intensity white square horizontally and vertically 
centered. Height and width defined by parameter as the 
percentage of height and width of the frame (default 30). 

Motion Pattern 

 

Horizontally moving color bar pattern. The pattern is shifted to 
left one pixel in each frame in a sequence. The length of the 
sequence is defined with parameter. Range 0 to 34 (default is 
20) 

Custom Image 

 

Bitmap image uploaded by the user. Click on the Custom 
Images panel to browse. By default, Unigraf test image will 
be used. 

 

More test patterns can be downloaded e.g. from www.icdm-sid.org/downloads/testpatterns.html. 
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APPENDIX E: SINK, SOURCE AND REPEATER 
DUT TESTS 

The tables below list the Unigraf TSI SDK Test Cases that you can run in Sink DUT Testing / Source DUT 

Testing tabs of UCD Console, their definition in TSI Reference Manual and the licensing needed. 

Source DUT Testing 
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CRC based Video Test Set 
CRC based single frame reference video test 
(TSI_TEST_VIDEO_CRC_SINGLE_REF) ✓    

 
CRC based single frame stability test 
(TSI_TEST_CRC_VIDEO_STABILITY) 

✓    

 
CRC based sequence of frames reference video test 
(TSI_TEST_CRC_VIDEO_SEQUENCE) 

✓    

 
CRC based continuous sequence of frames reference video test 
(TSI_TEST_CRC_CONT_VIDEO_SEQUENCE) ✓    

Link Test Set 
Link Training at All Supported Lane Counts and Link Rates 
(TSI_TEST_DP_SIMPLE_LINK) 

✓    

DP 1.4a Link Layer CTS 
4.2.1.1 – 4.2.1.5, 4.2.2.1 – 4.2.2.10, 4.3.1.1 – 4.3.1.13,  
4.3.2.1 – 4.3.2.5, 4.3.3.1, 4.4.1.1 – 4.4.1.3, 4.4.2, 4.4.3,  
4.4.4.1 – 4.4.4.6, 4.5.1.1 – 4.5.1.2, 4.6.1.1 – 4.6.1.9 

 ✓   

DisplayID / EDID CTS 4.7.1.1 – 4.7.1.4, 4.7.2.1 – 4.7.2.2, 4.7.3.1 – 4.7.3.3, 4.7.4.1   ✓  

HDCP 2.3 CTS 1A Test Set HCDP2.3 CTS 1A-01 – HCDP2.3 CTS 1A-13    ✓ 

HDCP 2.3 CTS 1B Test Set HCDP2.3 CTS 1B-01 – HCDP2.3 CTS 1B-10    ✓ 
 

Sink DUT Testing  
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DP 1.4a Link Layer CTS 
5.2.1.1 – 5.2.1.12, 5.2.2.1 – 5.2.2.9, 5.3.1.1 – 5.3.1.9,  
5.3.2.1 – 5.3.2.2, 5.4.1.1 – 5.4.1.4, 5.4.2, 5.4.3.1 – 5.4.3.2,  
5.4.4.1 – 5.4.4.6, 5.5.1.1 – 5.5.1.7, 5.6.1.1. – 5.6.1.26, 5.6.2.1 – 5.6.2.14 

 ✓   

DisplayID / EDID CTS 

5.7.1.1. – 5.7.1.5, 5.7.2.1 – 5.7.2.8, 5.7.3.1 – 5.7.3.5, 5.7.4.1 – 5.7.4.3, 
5.7.4.5, 5.7.5.1 – 5.7.5.2, 5.7.6.1 – 5.7.6.5, 5.7.7.1 – 5.7.7.6,  
5.7.7.1 – 5.7.7.6, 5.7.8.1 -5.7.8.6, 5.7.9.1 – 5.7.9.3, 5.7.10.1 – 5.7.10.3, 
5.7.11.1 – 5.7.11.5, 5.7.12.1 – 5.7.12.2 

  ✓  

HDCP 2.3 CTS 2C Test Set HCDP2.3 CTS 2C-01 – HCDP2.3 CTS 2C-06    ✓ 
 

Repeater DUT Testing  
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HDCP 2.3 CTS 3A Test Set HCDP2.3 CTS 3A-01 – HCDP2.3 CTS 3A-06    ✓ 

HDCP 2.3 CTS 3B Test Set HCDP2.3 CTS 3B-01 – HCDP2.3 CTS 3B-07    ✓ 

HDCP 2.3 CTS 3C Test Set HCDP2.3 CTS 3C-01 – HCDP2.3 CTS 3C-25    ✓ 

*) Separate licenses for testing Sink, Source, Branch (LL CTS) and Repeater (HDCP CTS) DUT. 

LL Branch license and HDCP Repeater license also cover Source DUT and Sink DUT testing. 
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CRC Based Video Test Set – DP RX 

CRC Based Single Reference Frame Video Test 

The test compares captured frames to a provided reference. 

TE compares the video mode (Frame Width, Height, BPP and optionally Frame rate) to 

provided parameters and after that captures frames and compares the CRC (check sum) of 

their three color components to the provided reference until the number of bad frame limit 

provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if video mode does not match or the number of bad frames is 

exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the 

hard disc. 

Parameters in use 

▪ Test Timeout (default 100 000 ms) 

▪ Total number of frames (default 2 000 ms) 

▪ Number of bad frames allowed (default 2) 

▪ Reference width (default 1920) 

▪ Reference height (default 1080) 

▪ Reference BPP (default 24) 

▪ Expected frame rate (mHz) 

▪ Frame rate tolerance (mHz) 

▪ Reference CRCs (R, G, B) 
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CRC Based Single Frame Video Stability Test 

The test verifies that the captured video is stable. 

TE captures a frame and sets the CRC of its color components as reference. After that TE 

captures frames and compares their CRC (check sum) to the reference until the number of 

bad frame limit provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the 

hard disc. 

Parameters in use 

▪ Test Timeout (default 100 000 ms) 

▪ Total number of frames (default 2 000 ms) 

▪ Number of bad frames allowed (default 2) 

CRC Based Sequence of Reference Frames Test 

The verifies that a sequence of frames is captured in the right order. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate) to 

provided parameters. After that captures frames to find a frame with matching CRC (check 

sum) of their three color components to the first provided reference. After the first 

matching CRC is found it compares the CRC of the following frames until the Number of 

frames tested parameter is reached.  

The test is judged FAIL if video mode does not match, the first frame in the list is not found 

or the CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the 

hard disc. 

Parameters in use 

• Test Timeout (default 100 000 ms) 

• Number of frames to be tested (default 20) 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz) 

• Frame rate tolerance (mHz) 

▪ Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the 

reference frame list should be different. 
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CRC Based Continuous Sequence of Reference Frames Test 

The test verifies that a sequence of frames is captured in the right order many times 

repeatedly. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate and 

Color format) to provided parameters. After that captures frames to find a frame with 

matching CRC (check sum) of their three color components to the first provided reference. 

After the first matching CRC is found it compares the CRC of the following frames until 

the Number of frames tested parameter is reached. After that it resets the list and starts from 

the first CRC. The list is repeated until timeout or until the provided number of repetitions 

is reached. 

The test is judged FAIL if video mode does not match, the first frame in the list is not found 

or the CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the 

hard disc. 

Parameters in use 

• Test Timeout (default 100 000 ms) 

• Number of frames to be tested (default 20) 

• Number of iterations 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz) 

• Frame rate tolerance (mHz) 

• Expected color format 

▪ Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the 

reference frame list should be different. 
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Link Test Set – DP RX 

Link Training at All Supported Lane Counts and Link Rates 

Test requests link training on all supported lane counts and link rates. Each link training 

must be successfully completed in order to pass the test. 

Parameters in use 

▪ Test Timeout (default 5 000 ms) 

▪ Max lane count supported by DUT (default 4) 

▪ Max lane rate supported by DUT as multiple of 0.27 Gbps.  

(valid settings 6, 10 and 20; default 20) 

▪ Long HPD pulse duration (default 1 000 ms) 

▪ Link training start timeout (default 5 000 ms) 

▪ Delay between test cycles (default 3 000 ms) 
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APPENDIX F: ADVANCED FILTERS 
This the description of the advanced methods for filtering transactions in DP AUX 

analyzer in Event Log. The following help text can be seen as well by clicking the 

Help button of the Edit Filter Rule dialog. 

Note Please note that Filters are a very powerful tool. They can however unintentionally 

hide valuable data from you. Please be careful when applying custom filters. 

A good practice is to start from an existing filter and gradually add new rules while 

testing their performance.  

 

Note  Filtering and selecting the columns for display do not affect the actual data 

acquisition. All transactions and their full data are always captured. 

Data pattern expressions 

A data-pattern expression is a string that describes how to determine if a data-block 

should be considered as "matched" or "unmatched". The syntax used with data-

pattern expressions in Aux Channel Analyzer is described below 

The data-block must be covered completely by the data-pattern expression. If the 

data block is shorter, or longer than the expression, then the data block is determined 

as "not matched". The '*' wildcard can be used to allow data blocks of any size to 

match. 

Whitespaces and new-lines are ignored and are allowed anywhere; White spaces and 

new-lines can be used strategically to make the expression more readable. 

For example: "*!(10)??(10)" is the same as "* ! (10) ? ? (10)" 

Comment blocks: 

Comments must be written enclosed in curly-braces '{' and '}'. 

Wildcards 

Wildcards used are '*' and '?' 

? = Match any single data byte only. 

* = Match any number of any data bytes. (including the possibility of matching NO 

data bytes) 

For data matching, the byte value must be enclosed in braces '(' and ')'. Use prefixes 

'$' to indicate HEX value, '%' to indicate BIN. No prefix indicates DEC. 

Examples: 

* ($10) ($00) : Matches any data pattern that has the bytes $10, $00 at end of data. 

? ($10) ($00) : Matches 3-byte data pattern that has $10 as second byte and $00 as 

third byte. 

* ($10) * ($00) : Matches any data pattern that has $10 and ending to a $00 byte. 

* ($10) * ($00) * : Matches any data pattern that has $10 and $00 after it. 

($10) ? * ($20) * : Matches any data pattern that has $10 as first byte, followed by 

$20 with at least one other byte in between. (i.e. will not match $10, $20) 

Use '!' to invert the match: 

!($00) = Match any data byte that isn't $00. 
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Use '?' within HEX or BIN value to ignore that bit in comparison: 

($??) = ? = Any data Byte. 

($?0) = Any data byte with bits 0-3 cleared. 

(%1???????) = Any data byte with bit 7 set. 

(%0??????1) = Any data byte with bit 7 cleared and bit 0 set. 

The '!' inversion can still be used: 

!(%??????00) = Matches any data byte ending to %10, %11, %01 but not %00. 

To match a single data byte with more than one value, separate the values with 

comma ',': 

(0, 1, 100, 200, 254) : Matches a data byte whose value is 0, 1, 100, 200 or 254. 

Invert the value group match with '!'. Value wildcard '?' is also allowed. 

Example: 

!(1, 2, 3) : Match any data byte other than 1, 2 or 3. 

!($?f, $f?) : Don't match data bytes with bits 0-3 set to 1, or data bytes that have bits 

7-4 set. 
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APPENDIX G: FIRMWARE RECOVERY 
PROCEDURE WITH QUARTUS PRIME 

FW Update Tool 
The chapter below describes a procedure for updating UCD-424 Firmware in a case when 

e.g. the normal FW Update procedure failed because a critical error.  

 Download the latest UCD-300/400 SW Bundle version from Unigraf website 

https://www.unigraf.fi/downloads/ and install it. Please do not launch UCD Console 

yet. 

 Recovery.zip file will be by default installed in 

C:\Program Files (x86)\Unigraf\TSI\UCD-400\Recovery.  

Perform the Recovery Procedure according to the instructions on the following pages. 

 Without removing power from the UCD-424 device perform FW update procedure as 

described in section 4 FIRMWARE UPDATE PROCEDURE earlier in this manual. 

Note The FW patch loaded in the UCD device during Recovery procedure is stored in a 

temporary memory. When power is removed from UCD device, the content of the 

temporary memory will be erased. Therefore, please do not power down the UCD 

device after performing the Recovery before instructed in the end of the FW Update 

procedure. 

 

If power will accidentally be removed before the FW Update procedure, Recovery 

procedure needs to be re-initiated. 

 

https://www.unigraf.fi/downloads/
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Recovery Procedure 
The Recovery patch is programmed to UCD Device with a separate tool called  

Quartus Prime (includes Nios II EDS). The tool can be downloaded from Intel® FPGA 

website: 

https://fpgasoftware.intel.com/16.1/?edition=lite&platform=windows 

On the download page, please Select release 16.1. Please download Quartus Prime 

(includes Nios II EDS). 

Note: Registering is needed for the download. 

Please download and install the tool in the PC. 
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Connect to the UCD-424 Unit 

 Power on the UCD-424.  

 Connect UCD-424 with a USB cable to the PC through Programmer connector.  

(Pls refer to page 8 of this document) 

Programming the FW 

Please locate the Recovery.zip file. It is by default installed in 

C:\Program Files (x86)\Unigraf\TSI\UCD-400\Recovery. Extract the content of the zip file 

in a folder in your PC, e.g., c:\Temp 

 Run Nios II 16.1 Command Shell application as Administrator 

Note: Nios II 16.1 Command Shell application needs to be run as Administrator  

(Right click with mouse and select Run as Administrator) 

 

Hint: Right click on the top edge of Command Shell and select Edit > Paste to paste the 

commands below 

 Select the folder location where the content of the Recovery.zip file was extracted. For 

example (C:/Temp) 

cd /cygdrive/c/Temp 

 Run the loader. 

source recovery.sh 

This instruction will load a temporary patch to the FW of the UCD Device to enable normal 

FW Update procedure 

 Once the upload has completed, please close the commend shell. 

 Launch UCD Console and initiate FW Update by selecting Tools > Firmware update. 

Please follow the instructions given in section 4 FIRMWARE UPDATE PROCEDURE 

earlier in this manual. 

Note The FW patch loaded in the UCD device during Recovery procedure is stored in a 

temporary memory. When power is removed from UCD device, the content of the 

temporary memory will be erased. Therefore, please do not power down the UCD 

device after performing the Recovery before instructed in the end of the FW Update 

procedure. 

 

If power will accidentally be removed before the FW Update procedure, Recovery 

procedure needs to be re-initiated. 

 Once FW update procedure has completed, cycle power on the UCD Device (switch off 

power > wait for 10 seconds > turn on power).  

Note Please cycle the power on the UCD-424 unit to enable the FW update (switch off 

power > wait for 10 seconds > turn on power). 

After Recovery procedure has been completed, you can delete the files stored in e.g., 

C:/Temp. 
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